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SISSEJUHATUS 

 

Teadusliku töö koostamine on oluline õpioskus, mis nõuab autorilt materjalide leidmise, 

mõistmise, tõlgendamise ning uue materjali korrastamise võimet, arendab kriitilist mõtle-

mist ja oskust iseseisvalt töötada. Hea uurimuslik töö on sisukas, teadusliku sõnakasu-

tusega, keeleliselt korrektne ning usaldusväärselt ja korralikult vormistatud. Uurimistöö 

koostamise ja vormistamise nõuded on küll suures plaanis universaalsed, kuid teatud nüan-

sid on õppe- ja teadusasutuseti erinevad. Siinse õppevahendi eemärk on võimalikult selgelt 

ja lihtsalt tutvustada üldkehtivaid nõudeid ja reegleid, millest Tallinna 32. Keskkooli 

(T32K) õpilane peab uurimistööd koostades ja vormistades lähtuma. 

 

Juhend on koostatud küll uurimistöid silmas pidades, kuid erinevatele õpilastöödele esita-

tavad vormistamisnõuded on üsna sarnased. Seega kehtivad juhendis toodud vormistamis-

juhised ka referaatidele, aruannetele ja teistele mahukamatele kirjalikele töödele, kui aine-

õpetaja ei nõua teisiti. 

 

Käesolevas juhendis on vormistamisjuhiste andmisel silmas peetud tekstitöötlusprogrammi 

MS Word. Mõne teise tekstitöötlusprogrammi kasutamisel tuleb vormistus viia täpsesse 

vastavusse selle juhendi nõuetega. 

 

Kõik Tallinna 32. Keskkoolis kirjutatud uurimistööde autoriõigused kuuluvad nii töö kirju-

tajale kui Tallinna 32. Keskkoolile. 

 

 

Tööindu, avastamisrõõmu ja sisukaid uurimistöid! 
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MÕISTED, KASULIKUD ALLIKAD 

 

Selleks, et uurimistööd tutvustama hakata ja samm-sammult uurimistöö etappe kirjeldada, 

peab teadma mõningaid teadustöödega seotud mõisteid. 

 

UURIMISTÖÖ – õpilase valitud ja juhendaja poolt aktsepteeritud teemal iseseisvalt kirju-

tatud töö, mis vastab käesoleva metoodilise juhendi nõuetele. Uurimistöö toetub mitmele 

algallikale ja sisaldab autori enda panust. Õpilase uurimistöö põhieesmärkideks on teadus-

liku kirjandusega töötamise, andmete kogumise ja analüüsimise ning teadusliku töö vor-

mistamise kogemuse saamine. Uurimistöö sisaldab uurimusliku protsessi konkreetset tule-

must, st kirjalikku aruannet sellest, mida õpilane uuris, kuidas ta uuris ning millised on 

järeldused ja tulemused, milleni õpilane töö käigus jõudis. 

 

REFERAAT – mingi teema, probleemi või kirjatüki kokkuvõtlik ülevaade. Referaat kirju-

tatakse kokku teiste autorite töödest, kuid selles esitatakse ka referaadi koostaja omapoolne 

arvamus ja järeldused. Referaadi koostamine nõuab töös kasutatud kirjanduse allikates esi-

nevate faktide ja mõtete ühendamist ning võrdlemist. Referaadi eesmärgiks on arendada 

ainealase kirjandusega töötamise ja enda väljendamise oskust. 

 

PROBLEEM – lahendust nõudev küsimus või raskesti lahendatav ülesanne. Teiste sõna-

dega uurimisülesanne. Uurimistöö teostaja peab enesele ise püstitama küsimused, valima 

neist välja jõukohasemad ning leidma iseseisvalt (juhendaja toetusel) vastused. 

 

HÜPOTEES – oletus või tõestamata väide, mille uurimistöö autor on esitanud ning mida ta 

hakkab oma töös tõestama või ümber lükkama. Hüpotees peab olema kontrollitav ja põh-

jendatav. Vastasel juhul ei ole uurimistöö tegemisel mõtet, kuna tulemust saada on või-

matu. 

Näiteks väidab õpilane, et T32K gümnasistidest söövad hommikul putru vähemalt 

pooled. Selleks, et hüpotees leiaks kinnitust või lükataks ümber, tuleb gümnasistide 

seas läbi viia vastav uurimus. 

 

REFEREERIMINE – alusteksti(de) materjali edasiandmine oma sõnadega. Refereeringule 

tuleb alati korrektselt viidata. 
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TSITEERIMINE – alusteksti edasiandmine sõna-sõnalt. Tsitaadile tuleb alati korrektselt 

viidata. 

 

VIIDE ehk TEKSTIVIIDE – andmed autori ja teose kohta, mis tuleb alati lisada, kui töös 

edastatakse kellegi teise seisukohti või andmeid. Viide sisaldab kindlaid osi ning paiguta-

takse teksti sisse ümarsulgudesse. 

 

VIITEKIRJE ehk BIBLIOKIRJE – töö lõpus kirjanduse loetelus esitatav täielik info iga 

töös refereeritud ja viidatud allika kohta. 

 

JUHENDAJA – on üldjuhul T32K õpetaja, kes aitab nõu ja jõuga õpilasel uurimistööd 

koostada. Ta on õpilase innustaja ja tugisammas, kuid samas ka töö õiglane kritiseerija. 

Juhendaja ei ole uurimistöö autor, vaid suunab ja juhib õpilast sisuliselt täiusliku töö poole. 

Töö andmete ja viidete õigsuse ning vormistuse korrektsuse eest vastutab siiski õpilane, 

mitte juhendaja. Valminud uurimistöö kaitsmisele lubamise otsustab töö juhendaja. 

 

RETSENSENT – uurimistöö arvustaja, kelleks on antud töö ainevaldkonda hästi tundev 

T32K õpetaja või vastava aine spetsialist väljaspool kooli. Retsensent koostab uurimistööle 

retsensiooni, mis annab töö vormist ja sisust tagasisidet. 
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Uurimistöö koostamisel on abiks ka järgmised allikad: 

» http://www.eki.ee/dict/qs/ – ÕS 2006 veebiversioon 

» http://www.eki.ee/dict/ekss/ – „Eesti keele seletava sõnaraamat“ 

» http://www.eki.ee/dict/synonyymid/ – „Sünonüümisõnastik“ 

» http://tallinn.ester.ee/ – Eesti suuremate raamatukogude elektrooniline kataloog 

» Hirsjärvi, Sirkka, Pirkko Remes, Paula Sajavaara 2007. Uuri ja kirjuta. Tallinn: 

Medicina. 

» Ehala, Martin 2000. Kirjutamise kunst. Tekstiõpetuse õpik. Tallinn: Künnimees. 

» Vija, Maigi, Kadri Sõrmus, Irene Artma 2008. Uurimistöö kirjutajale. Tartu: Atlex. 

» Uuspõld, Ellen 2000. Üliõpilastööde vormistamise juhend. Tartu Ülikooli eesti keele 

õppetool. Tartu: Tartu Ülikool. 

» Roomets, Silvi 2006. Üliõpilastööd ja nende vormistamine arvutil. Tallinn: Rebellis. 

http://www.eki.ee/dict/qs/
http://www.eki.ee/dict/ekss/
http://www.eki.ee/dict/synonyymid/
http://tallinn.ester.ee/
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1. UURIMISTÖÖ EESMÄRGID 

 

Teadusliku töö koostamine gümnaasiumis on oluline õpioskus, mis valmistab õpilase ette 

tulevasteks teaduslikeks töödeks. Uurimistöö eesmärgiks on: 

 anda õpilasele kogemusi teaduslikuks tööks – kuidas koguda erialast teaduskirjan-

dust ja andmeid ning neid töödelda, kuidas seostada teooria uurimusliku osaga; 

 anda õpilasele võimalus uurida põhjalikumalt mõnd probleemi või ainevaldkonda; 

 suurendada õpilase oskust iseseisvalt mõelda, luua seoseid, teha järeldusi ja kokku-

võtteid; 

 julgustada õpilast avaldama oma arvamust ja võtma vastu otsuseid; 

 arendada õpilase koostöö- ja ajaplaneerimisoskust; 

 soodustada korrektse kirjaliku väljendusoskuse (teaduskeele ja erialase termino-

loogia) ning teadustöö korrektse (juhendi nõudeid rangelt järgiva) vormistusoskuse 

omandamist; 

 suurendada õpilase avaliku esinemise kogemust uurimistöö kaitsmise kaudu. 
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2. UURIMISTÖÖLE ESITATAVAD SISULISED NÕUDED 

 

Teadustöödele, sealhulgas ka õpilastöödele kehtivad üldtunnustatud kriteeriumid: 

 uudsus ja aktuaalsus – kõige tähtsam kriteerium, mis nõuab seda, et uurimistöö 

sisaldaks midagi uut ja esmakordset, mida varasemates töödes pole esitatud; 

 objektiivsus – autor on erapooletu; esitab kõik uuringust tulenevad andmed ka siis, 

kui need on hüpoteesile vasturääkivad; isiklikke tundeid uurimistöös ei kajastata; 

 tõestatavus – kõik töös esitatavad väited peavad olema argumenteeritud ja toetuma 

faktidele; 

 tulemuste kontrollitavus – arvutus- ja arutluskäigud tuleb esitada nii, et töö lugejal 

on võimalus saadud tulemusi kontrollida. Teiste autorite esitatud seisukohad peavad 

olema viidatud nii täpselt, et neid on võimalik vajaduse korral algallikast leida; 

 täpsus – kõik töös kasutatavad terminid, mõisted tuleb korrektselt ja täpselt määrat-

leda; andmed ja arvud tuleb esitada täpselt; viitamine olgu korrektne ja süsteemne; 

 selgus – töö peab olema struktureeritud nii, et see oleks üheselt arusaadav; kõik 

vajalikud mõisted tuleb defineerida; põhimõte nii lihtsalt kui võimalik; sõnadevalik 

täpne ja üheselt mõistetav; 

 süsteemsus – teaduslik on ainult selline töö, kus erinevad väited ja argumendid on 

ühendatud üheks vastuoludeta tervikuks ehk süsteemiks; 

 kriitilisus – olemasolevaid seisukohti tuleb vaadelda kriitiliselt; allikakriitika; 

 selektiivsus – vali valdkonnaga seotud erinevate probleemide, andmete ja meetodite 

seast sellised, mis viivad kõige lühemat teed pidi tulemuseni. 

 

Uurimistööd planeerides ja kirjutades tasub mõelda, et seda ei tehta ainult uurija isikliku 

uudishimu rahuldamiseks. Uurimistöö peab pakkuma midagi huvitavat ja uut ka lugejale. 
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3. UURIMISTÖÖLE ESITATAVAD EETILISED NÕUDED 

 

Teaduslikus uurimistöös tuleb järgida uurimuse vastavust eetikanõuetele: 

 lubamatu on teiste autorite andmete, tekstide ja tsitaatide kasutamine algallikale 

viitamata. Plagieeritud töid ei võeta kaitsmisele või kui plagieerimine avastatakse 

pärast kaitsmist, siis kaitsmise tulemus tühistatakse; 

 kuna uuringu mõju on temas osalevatele isikutele paratamatu, siis tuleb tagada, et 

see ei põhjustaks osalejatele kahju (sh füüsilist, vaimset, kõlbelist, materiaalset); 

 uuringus osalemine peab olema vabatahtlik, igal uuritaval on õigus selles mitte osa-

leda või katkestada osalemine suvalisel etapil; 

 uuritavate isikute anonüümsus peab olema tagatud; 

 uuritavate isikute personaalsete andmete, fotode, videosalvestuste, joonistuste jms 

materjali avaldamiseks peab olema vastava isiku nõusolek. 
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4. UURIMISTÖÖ LÄBIVIIMISE ETAPID 

 

Igasugune kirjutamine koosneb mitmest etapist. Ka uurimistöö kirjutamine on protsess, 

mis koosneb erinevatest etappidest. 

1. etapp  õpilane valib õpetajate koostatud teemapangast endale huvipakkuva teema 

ja võtab ühendust vastava teema välja pakkunud õpetaja ehk juhendajaga. Kui 

õpilasel on endal uurimisvaldkond ja teema, mis teda huvitab, siis leiab ta ise 

sobiva õpetaja, kes võiks tööd juhendada. (aprill–mai) 

2. etapp  koos juhendajaga sõnastatakse uurimistöö eesmärk ja probleem ehk uuri-

misülesanne, mida hakatakse antud tööga lahendama. Vajadusel püstitatakse 

hüpotees(id). Veel kavandatakse koos juhendajaga töö uurimuslik pool, leitakse 

sobiv metoodika ja koostatakse uurimistöö esialgne kava, samuti ajakava. (mai) 

3. etapp  õpilane tutvub juhendaja soovitatud ja enda poolt leitud vastavasisulise kir-

jandusega antud teema kohta, teeb loetu kohta märkmeid, leiab oma vaatenurga 

ning kavandab töö teoreetilise osa esialgse ülesehituse. (mai–september) 

4. etapp  õpilane viib läbi uurimuse, vaatluse, andmete kogumise jms. Samuti tegeleb 

uurimistöö teoreetilise poolega ning vormistab läbitöötatud kirjanduse põhjal 

oma töö teoreetilise peatüki esialgse variandi. ((juuni) september–november) 

5. etapp  õpilane analüüsib uurimuse käigus saadud tulemusi. Õpilane kirjutab läbi-

viidud uuringust kokkuvõtte, annab ülevaate ka kasutatud metoodikast ning 

esitab uurimusest tulenevad järeldused. Nii valmib uurimistöö uurimusliku osa 

esialgne variant. (november–jaanuar) 

6. etapp  õpilane seostab teoreetilise osa ja uuringu tulemused ning kirjutab uurimis-

tööle sissejuhatuse ja kokkuvõtte. Valmib uurimistöö parandatud, st eelviimane 

variant. (jaanuar–veebruar) 

7. etapp  töö vormistamine ja n-ö viimase lihvi andmine. Õpilane kirjutab oma tööle 

nii eesti- kui võõrkeelse resümee. Lõplikult valmis uurimistöö esitatakse retsen-

sendile ja kaitsmiskomisjonile. (veebruar–märts) 

8. etapp  õpilane valmistab koos juhendajaga ette uurimistöö kaitsekõne ning seda 

ilmestava näidismaterjali (PowerPoint esitlus vms). Samuti kirjutab kaasõpilase 

tööle retsensiooni ja tutvub oma tööle antud retsensioonidega. (märts–aprill) 

9. etapp  uurimistöö kaitsmine. (aprill) 
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Uurimistöö viiakse läbi joonisel 1 toodud lihtsustatud etappide kaupa. 

 

Joonis 1. Uurimistöö läbiviimise etapid 

 

Uurimistöö valmib tõrgeteta ainult siis, kui peetakse kinni kokkulepetest ja ajakavast 

ning õpilane teeb juhendajaga aktiivselt koostööd (vastupidi loomulikult ka)! 

 

4.1. Teema valik 

 

Uurimistöö teema ei ole referatiivne, vaid teema peab eeldama uurimisprobleemi või hüpo-

teesi. Õpilasuurimistöö puhul on soovitav keskenduda pigem kitsamale ja konkreetsemale 

teemale. Samuti on soovitatav valida teema, mida lugedes hakkab kohe mõte liikuma ning 

tekib ettekujutus, kuidas sellist teemat uurima hakata. 

 

Teema ja juhendaja valik 

Uurimistöö esialgse kava koostamine 

 

Kirjanduse ja muude allikatega tutvumine 

Materjali kogumine 

Materjali analüüs 

Uurimistulemuste tõlgendamine 

Uurimistöö kirjalik vormistamine 

Uurimistöö kaitsmiseks valmistumine ja 

retsensioonidega tutvumine 

Esimene kollokvium 

Uurimistöö kaitsmine 

Teine kollokvium 

Uurimistöö esitamine 
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Uurimistöö teema valikul tasub silmas pidada: 

 teema aktuaalsust, olulisust ja originaalsust; 

 teema konkreetsust ja piiritletust; 

 võimalust teemat edasi arendada järgmistes töödes; 

 võimalusi erialakirjanduse hankimiseks ning andmete kogumiseks; 

 oma huve ja võimeid. 

 

Teema valikul püstitatakse ka töö esialgsed eesmärgid ning uurimisküsimused. Nii mõel-

dakse läbi, kuhu üldjoontes tahetakse jõuda. 

 

4.2. Kava koostamine 

 

Koos juhendajaga püstitatakse tööle eesmärgid ja sõnastatakse uurimisülesanne, st prob-

leem, mida hakatakse antud tööga lahendama. Samuti püstitatakse vajadusel uurimisküsi-

mused ja uurimistöö hüpotees(id). Veel kavandatakse koos juhendajaga töö uurimuslik 

pool ja leitakse sobiv metoodika. Siinkohal tuleks vastus leida järgmistele küsimustele: 

 miks antud teema käsitlemine on vajalik, oluline? 

 miks antud uurimust koostatakse? 

 kuidas antud uurimust läbi viia? 

 milliste järeldusteni selle tööga soovitakse jõuda ? 

 

Töö eesmärkide, uurimisülesannete ja kirjandusega tutvumise alusel koostatakse töö esi-

algne kava. Selles näidatakse kavandatavate peatükkide ja alapeatükkide pealkirjad, 

nende plaanitav järjestus ning uurimistöö koostamise ajakava ehk kalenderplaan. 

 

Uurimistöös on tavaliselt sissejuhatus, 2−3 sisupeatükki, mille pealkirjad ei korda üld-

teemat, ja kokkuvõte. Pealkirjade sõnastamisel tuleb vältida retoorilisi küsimusi, hüüatusi, 

ilukirjanduslikku stiili. Samuti ei tohiks pealkirjas ilmneda uurimuse järeldused. Oluline 

on, et kava oleks terviklik, selge ja loogiline, ning töö ülesehitus oleks allutatud töö ees-

märkidele. 

 

* T32K õpilasel tuleb uurimistöö kavast esitada ammendav ülevaade nii komisjonile 

kui kaasõpilastele esimesel kollokviumil, kus selgitatakse välja planeeritava uurimistöö 
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aktuaalsus, vajalikkus, võimetekohasus ning õpilase ja juhendaja koostöö sujuvus. Komis-

jonile esitatava uurimistöö kava vormi leiab lisast 1. 

 

4.3. Uurimistöö hüpoteeside sõnastamine 

 

Samaaegselt uurimistöö eesmärkide püstitamise ja kava koostamisega tuleb läbi mõelda ka 

uurimistöö hüpotees(id). Hüpotees on tõestamata väide, st eeldatav vastus uurimisküsi-

musele. Hüpoteesi püstitamine on uurimistöö loominguline osa, kus õpilane kujutab endale 

ette võimalikke seoseid uuritavate objektide vahel ning sõnastab nendele tuginedes oma 

uurimisküsimuse hüpoteesi. 

 

Hüpotees peab arvestama varem avastatud seaduspärasusi, st see ei tohi olla vastuolus 

varem teaduslikul teel saadud tulemustega. Sellepärast on soovitatav enne hüpoteesi sõnas-

tamist tutvuda erialase kirjandusega. Lisaks peab hüpotees olema kontrollitav ja põhjen-

datav. Vastasel juhul ei ole uurimistöö tegemisel mõtet, kuna tulemust saada on võimatu. 

 

Siiski mitte iga teema ega valdkond eelda hüpoteesi(de) püsitamist, mistõttu tuleb lähtuda 

oma uurimistööst. Ka juhendaja oskab õpilasele siinkohal nõu anda ja õpilast vajadusel 

hüpoteeside sõnastamisel abistada. 

 

4.4. Teoreetilise kirjandusega tutvumine 

 

Töö koostamiseks vajaliku teemakohase kirjanduse leidmine, läbitöötamine ja analüüsi-

mine on õpilase iseseisev ülesanne, sest ainult nii on võimalik endale selgeks teha töö teo-

reetiline taust. Teoreetilise kirjandusega tutvumist võiks alustada mõne hea õpikutekstiga, 

samas õpikuid kasutatakse uurimistöös allikana siiski vaid erandkorras. Edasi tasub otsida 

vajalikke materjale raamatukogude andmebaasidest (vt http://tallinn.ester.ee/) märksõnade 

abil. Samuti kasutada teatmeteoseid ja interneti otsingumootoreid, unustamata seejuures 

allikakriitikat. Hea nipp on uurida läbitöötatud allika kasutatud kirjanduse nimekirja, sest 

sealtki saab väärt vihjeid teistele asjakohastele teostele. Oluline on otsida varasemaid, aga 

kaasaegseid sama valdkonna uurimusi ja tutvuda nende tulemustega. Lisaks võib kasutada 

internetimaterjale, kui neil on autor ja väljaandja (nt gümnaasium, ülikool, kirjastus vms). 

http://tallinn.ester.ee/
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Teoreetilise kirjanduse leidmisel abistab õpilast kindlasti ka juhendaja. Siinkohal kehtib 

reegel, et liiga vähe kirjandust uurida on patt, samas liiga palju kulutab aga asjatult aega. 

Uurimistöö raames teoreetilist kirjandust lugedes on mahust hoopis olulisem loetust aru-

saamine, olulise eristamine ebaolulisest ning materjali paigutamine enda töö konteksti. 

Soovitav on teha endale kirjandusest viidetega väljakirjutisi, vastasel juhul võib hiljem olla 

raske loetus orienteeruda. Meeles tuleb ka pidada, et uurimistöö aluseks ei sobi võtta vaid 

ühe autori kirjutisi. 

 

* T32K uurimistöös peab olema kasutatud vähemalt 5 teoreetilist allikat ning kasutatud 

allikatest mitte rohkem kui pooled tohivad olla internetiallikad. 

 

4.5. Andmete kogumine uurimuse jaoks 

 

Uurimistöö käigus kogutakse materjali töö uurimisprobleemi lahendamiseks ja hüpoteeside 

kontrollimiseks. Teoreetilise materjali allikaks on kirjandus. Empiiriliseks materjaliks 

on uurimisküsimusest lähtuvad andmed, mille kogumiseks kasutatakse vastavat andme-

kogumismeetodit, nagu vaatlust, küsitlust, eksperimenti, intervjuud, katset, testi, võrdlust, 

dokumentide (õpilastööd, kirjad, päevikud, käsikirjad, joonised/joonistused, fotod, heli-

salvestused, videod jms) analüüsi vms. 

 

Empiirilised uurimused jagunevad uurimisandmete kogumis- ja tõlgendamisviisist lähtudes 

kvantitatiivseteks ja kvalitatiivseteks uurimusteks. Kvantitatiivse uurimuse puhul püstita-

akse uurimuse eesmärgid ja hüpoteesid ning otsitakse teavet, mida on võimalik mõõta ja 

arvudega väljendada, st tulemused on numbrilised. Kvantitatiivse uuringu eesmärgiks on 

nähtuste kirjeldamine, seletamine, testimine ja ennustamine. Tihti üritatakse kvantitatiivse 

uuringu puhul seletada tervikut ilma eranditeta. Kvantitatiivse uurimuse põhiküsimused: 

kui palju? mil määral? mis ulatuses? miks? milleks? Järeldusteni jõutakse sta-

tistilise andmeanalüüsi põhjal. Kvalitatiivse uurimuse korral püstitatakse eesmärgid ja 

uurimisküsimused ning otsitakse teavet, mida arvuliselt väljendada on ebaotstarbekas või 

võimatu, st tulemused on üldjuhul sõnalised (näiteks uuritava nähtuse põhjused, küsitletute 

isiklik arvamus jne). Kvalitatiivse uuringu eesmärgiks on nähtuste kirjeldamine, mõistmine 

ja tõlgendamine. Kvalitatiivse uurimuse põhiküsimused: kuidas? mis?  missugune? Järel-

dusteni ei jõuta statistika põhjal, vaid leitakse n-ö mustreid. 
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Empiirilise materjali kogumine ning kasutatavate meetodite valik sõltub nii uurimisküsi-

musest kui uurimisteemast. Oluline on materjali kogumise protseduuri korrektsus. Siin-

kohal tuleb õpilasel kindlasti nõu pidada juhendajaga, et materjalide kogumise protseduur 

koos väga põhjalikult läbi mõelda. 

 

Uurimistöö materjali kogumise etapi võtmesõna on seega planeerimine. Materjali kogu-

mist ette valmistades tuleb silmas pidada, et kogutava materjaliga saaks vastata püstitatud 

uurimisküsimustele. Liigse materjali kogumist tuleks töömahu tõttu vältida. Üldjuhul on 

andmestik piisav siis, kui autor saab selle põhjal midagi väita ja järeldada. 

 

4.6. Kogutud materjali läbitöötamine ehk analüüs 

 

Kogutud materjal tuleb läbi töötada, süstematiseerida ning seejärel analüüsida. Meeto-

did, mida andmeanalüüsil kasutatakse, sõltuvad uuritavast küsimusest ning valdkonnast 

laiemalt. Juhendaja aitab õpilasel leida sobivaid analüüsimeetodeid. 

 

Materjali analüüsi juures on viimane aeg alustada ka uurimistöö reaalse kirjutamisega. 

Vastasel juhul viiakse analüüsides läbi hulk protseduure, mis hiljem osutuvad ebavaja-

likeks. Uurimistöö kirjutamise aluseks võetakse töö esialgne kava, mida vastavalt vaja-

dusele muudetakse ja täiendatakse. Kindel kava on kirjutamisel äärmiselt vajalik, vastasel 

juhul võidakse kirjutama jäädagi. 

 

* T32K õpilasel tuleb oma uurimistööst esitada vahearuanne uurimistööde teisel kollok-

viumil, kus selgitatakse välja töö edenemine ja hetkeseis ning õpilase ja juhendaja koostöö 

sujuvus. Komisjonile esitatava vahearuande vorm on toodud lisas 2. Aruanne eeldab, et 

õpilane on oma uurimistööga jõudnud vähemalt materjali analüüsini ja uurimistööst on 

valmis u 50%. 

 

4.7. Uurimistulemuste tõlgendamine ja järelduste tegemine 

 

Uurimistulemuste tõlgendamine ja üldistamine tähendab kogutud andmete ja nende ana-

lüüsitulemuste lahtimõtestamist laiemas kontekstis. Õpilane tõlgendab kogutud andmeid ja 
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arutleb nende põhjal, mida saadud tulemused näitavad või tähendavad. Tulemusi saab esi-

tada tabelite ja skeemidena, kuid nendes sisalduvad andmed (arvud, protsendid jms) tuleb 

kindlasti tekstis ka lahti kirjutada. Uurimistulemuste tõlgendamise käigus peaks saama 

vastused järgmistele küsimustele: 

1) Mida saadud tulemused tegelikult  näitavad? 

Näiteks tulemus, et poiste keskmine hinne füüsikas on oluliselt kõrgem tüdrukute 

omast, näitab, et poiste õpitulemused füüsikas on tüdrukute omadest paremad. 

2) Kas tulemusi võib pidada usaldusväärseteks ? 

Oma uurimistöö esimeseks kriitikuks peab olema õpilane ise! Eelkõige mõjutab 

usaldusväärsust materjali kogumise ja analüüsimise korrektsus ja põhjalikkus. 

3) Kas hüpoteesid leidsid kinnitust või mitte ? 

4) Milline on saadud tulemuste seos ja vastuolu varasemate uurimustega? 

Siinkohal on vaja orienteeruda sarnase teemaga tegelevates varasemates uurimis-

töödes. Vastuolusid võiks seejuures proovida põhjendada. 

5) Milles seisneb saadud tulemuste uudsus? 

Sellega näidatakse, miks just see töö n-ö suure teaduse kontekstis vajalik on. 

Rakendusliku suunitlusega tööde puhul tuleks siin näidata, kui kasulikud on tule-

mused praktikas. 

6) Millised on töö peamised järeldused? 

Järeldusi tehes tuleks saadud tulemuste põhjal välja pakkuda ka võimalusi teema 

edasiseks uurimiseks. 

 

4.8. Teoreetilise materjali ja uurimistöö tulemuste sidumine loogiliseks 

tervikuks 

 

Õpilane ühendab uurimistöö teooria osa ja läbiviidud uuringu tulemused loogiliseks 

tervikuks. Soovitatud on, et kõik peatükid ja vastavalt vajadusele ka alapeatükid algavad 

paarilauselise sissejuhatusega ja lõppevad paarilauselise lühikokkuvõttega. Samuti kirjutab 

õpilane oma tööle nüüd lõpliku sissejuhatuse ja kokkuvõtte ning vastavate aineõpetajate 

juhendamisel nii eesti- kui võõrkeelse resümee. Viimasena valmib korrektne sisukord, 

mis koostatakse tekstitöötluprogrammi vastavate käskluste abil (vt sisukorra koostamist 

ptk 5.2). Nii valmibki uurimistöö eelviimane variant. 
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4.9. Uurimistöö viimistlus 

 

Uurimistöö vormistatakse vastavalt konkreetse haridus- või teadusasutuse vormistamis-

nõuetele. Põhimõtteliselt on erinevate koolide vormistusnõuded küll sarnased, kuid nüansi-

liste erinevuste tõttu tuleb alati aluseks võtta selle asutuse vormistusjuhend, kuhu töö esi-

tatakse. T32K-s kaitstavad uurimistööd peavad vastama käesolevale juhendile. 

 

Uurimistööd kirjutades on kaval meeles pidada, et seda kirjutatakse lugejale. Seega peab 

kirjapandu olema mõistetav ka inimesele, kes küll tunneb valdkonda, kuid ei ole kursis 

konkreetse uurimisküsimusega. Kõik kasutatud alustekstid peavad töö autori enda mõtetest 

selgelt eristuma (vt viitamine ptk 6.3). 

 

Kui töö on valminud, tuleb see enne esitamist kindlasti paar korda läbi lugeda. Kirja-, 

sõnastus- ja trükivigade avastamiseks on kasulik lasta tööd lugeda ka mõnel kolmandal 

isikul. 
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5. UURIMISTÖÖ ÜLESEHITUS 

 

Uurimistöö koosneb kindlatest osadest, kusjuures nende järgnevus on teadustöö puhul 

oluline. Samas mingil määral on uurimistöö ülesehituses ka ainespetsiifilisi iseärasusi. 

Siinkohal tasuks õpilasel pidada nõu oma juhendajaga. 

 

T32K-s koosneb õpilasuurimus reeglina järgmistest osadest: 

TIITELLEHT 

SISUKORD 

KASUTATUD LÜHENDITE LOETELU (vaid vajadusel!) 

SISSEJUHATUS 

TÖÖ PÕHIOSA (15-25 sisulehekülge) 

1. Teoreetiline taust 

2. Uurimuslik osa, sh metoodika ülevaade 

3. Teooria ja praktika võrdlus ning seostamine uurimuse tulemustega 

KOKKUVÕTE 

KASUTATUD KIRJANDUS 

EESTIKEELNE RESÜMEE 

VÕÕRKEELNE RESÜMEE 

LISAD (vaid vajadusel!) 

 

Nii sisupeatükid, nende alapeatükid kui muud töö osad ja lisad pealkirjastatakse. 

Pealkirjade sõnastamisel tuleb vältida retoorilisi küsimusi, hüüatusi, ilukirjanduslikku stiili. 

Samuti ei tohiks pealkirjas ilmneda uurimuse järeldused. Kõikide peatükkide, sissejuha-

tuse, kokkuvõtte, kasutatud kirjanduse ja resümee pealkirjad kirjutatakse läbivate suur-

tähtedega (Format→Font→All Caps). Alljaotuste pealkirjad (sh lisade pealkirjad) kirju-

tatakse väiketähtedega, v.a suur algustäht. Peatükkide ning teiste alljaotuste pealkirjade 

järele punkti ei panda. 

 

Uurimistöö sisupeatükid ja alapeatükid nummerdatakse araabia numbritega (näiteks 

1., 2., 3. ja 1.1., 1.2. jne). Numbrite vahel ja lõpus on punkt, kuid tekstis osutamisel lõpus 

punkti ei ole (näiteks punkti 3.2.2 kohaselt). Et peatükki liigendada alapeatükkideks, peab 

viimaseid olema vähemalt kaks. Kui lisasid on rohkem kui üks, tuleb ka need nummerdada 
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araabia numbritega (näiteks Lisa 1, Lisa 2 jne). Soovitatav on kasutada kuni kolme-

tasandilist peatükkide hierarhia järjestussüsteemi. 

 

5.1. Tiitelleht 

 

Tiitelleht on töö esimene lehekülg, mis peab sisaldama järgmist informatsiooni: 

 tiitellehe ülaservas keskel õppeasutuse nimi; 

 9 rida allpool keskel töö koostaja ees- ja perekonnanimi; 

 selle alla järgmisele reale klass; 

 2 rida allpool tumedas kirjas keskel töö pealkiri (trükitähed, kirja suurus 16 või 18); 

 2 rida allpool keskel töö liik (uurimistöö); 

 3 rida allpool paremas servas juhendaja nimi ja amet või teaduslik kraad; 

 viimasel real keskel töö valmimiskoht ja aastaarv (komata!). 

 

Punkti tiitellehel ei kasutata. Leheküljenumbrit tiitellehele ei panda. Tiitelleht vormista-

takse Times New Roman kirjas suurusega 14 (pealkiri 16 või 18), reavahe 1,5 ja valdavalt 

keskjoondus (Justify). Tiitellehe näidis on toodud käesoleva juhendi lisas 3. 

 

Tiitellehe pöördel on uurimistöö autori ja juhendaja allkiri autoriõiguse seaduse täitmise 

kohta. Tiitellehe pööre vormistatakse Times New Roman kirjas suurusega 12, reavahe 1,5 

ja keskjoondus (Justify). Leheküljenumbrit tiitellehe pöördele ei panda. Tiitellehe pöörde 

näidise leiab lisast 4. 

 

5.2. Sisukord 

 

Sisukord hõlmab endas kõigi üksikute alajaotuste täielikke pealkirju koos nende algus-

lehekülgede numbritega. Sisukorda ei kuulu tiitelleht ega sisukord ise. Sisukorra liigen-

dus pealkirjadeks ja alapealkirjadeks peab vastama töös kasutatud liigendusele. Sissejuha-

tus, kokkuvõte ja kasutatud kirjanduse loetelu ei kuulu peatükkidena nummerdamisele, küll 

aga nummerdatakse sisupeatükid, alapeatükid ja vajadusel ka lisad, kui neid on rohkem kui 

üks (näiteks Lisa 1, Lisa 2 jne). 
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Sisukord koostatakse automaatselt tekstitöötlusprogrammi abil. Selleks, et tekstitöötlus-

programm saaks sisukorra (Table of Contents) luua, peavad kõik pealkirjad ja alapealkirjad 

olema eelnevalt vormistatud pealkirjadena (Heading). 

 

Sisukorra koostamisel viiakse kursor sisukorrale vastavasse kohta ja valitakse Insert→ 

Insert Table of Contents. Avanevas dialoogiaknas antakse käsud sisukorra vormistamiseks: 

 näidata lehenumbrid (Show Page Numbers), 

 joondada need paremale (Right Align Page Numbers), 

 kasutada pealkirja ja leheküljenumbri vahel täitesümboleid (Tab Leader), 

 määrata sisukorra vormindus. Formats pakub mitmeid võimalusi, mis kuvatakse 

aknal Preview, enam kasutatakse vormi From Template. 

 Show Levels määrab, mitu taset pealkirja hierarhiast lülitatakse sisukorda (valida 3 

või 4 vastavalt oma tööle). 

Klõps OK ja valmis on hüpertekstiline sisukord. 

 

Sisukord on otstarbekas koostada juba töö tegemise käigus, sest lingid sisukorras toodud 

pealkirjadest (View→Document Map) viivad vastava teksti juurde, kiirendades nii töös 

liikumist. Aeg-ajalt tuleb sisukorda uuendada ja kindlasti tuleb vahetult enne töö lõplikku 

väljaprintimist sisestada veel kord sisukorra moodustamise käsk: arvuti küsib Replace 

(Asendada), millele vastata jaatavalt. Arvuti koostatud sisukorras ei puudu ükski pealkiri, 

leheküljenumbrid sisukorras ja töös on vastavuses ning pealkirjad on stiililiselt korrektsed. 

 

Sisukorra näidis on toodud käesoleva juhendi lisas 5 (vt ka lk 2). 

 

5.3. Kasutatud lühendite loetelu 

 

Lühendite loetelu lisatakse tööle ainult sel juhul, kui töös on kasutatud üle kümne vähe-

tuntud lühendi või sümboli. Kõikidest loetelus toodud lühenditest tuleb kogu töö ulatuses 

ka kinni pidada. Üldlevinud lühendeid (näiteks lk, a, jne, nt, vt, vms, nn, n-ö) loetellu ei 

lisata. Samuti ei lisata loetellu lühendeid, mille täielikku kirjapilti uurija hinnangul kõik töö 

lugejad teavad (näiteks USA, ÜRO, ROK). 
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Kui töös kasutatakse vähem kui kümmet lühendit, defineeritakse nad esmakordsel kasu-

tamisel tekstis. Täieliku kirjapildi lõppu lisatakse sulgudesse lühend, mida edaspidi tekstis 

kasutama hakatakse (näiteks sisemajanduse kogutoodang (SKT)). 

 

5.4. Sissejuhatus 

 

Sissejuhatusel on järgmised peamised ülesanded: 

 Teema valiku põhjendamine. Põhjenduse parimaks viisiks on sisuline argumentat-

sioon, st teema uudsuse, aktuaalsuse, tähtsuse selgitamine, mitte kellegi kolmanda 

arvamusele apelleerimine (a’la õpetaja pakkus sellise teema välja ja arvas, et see on 

huvitav) ega isiklike motiivide väljatoomine. 

 Töö eesmärgi sõnastamine: mida soovitakse tõestada või ümber lükata, millisele 

probleemile otsitakse lahendust, millisele küsimusele otsitakse vastust. 

 Eesmärgi saavutamiseks püstitatud uurimisülesannete sõnastamine. Samuti püsti-

tatud hüpoteeside sõnastamine. 

 Töö ülesehituse selgitamine: antakse lühiülevaade igast sisupeatükist. 

 Kasutatavate andmete ja metoodika lühitutvustus. Varasemate uuringute ja olu-

lisemate uurijate mainimine. 

 

Sissejuhatuses võib autor tähelepanu juhtida nendele töö koostamisel ilmnenud asjaolu-

dele, mille teadmine aitab lugejal töö sisu paremini mõista. Sellisteks asjaoludeks võivad 

olla näiteks kogutud andmete esinduslikkuse ja hankimisega kaasnevad probleemid, aga ka 

isikute või institutsioonide nimetamine, kellelt on saadud abi töö kirjutamisel. Tuleb silmas 

pidada, et sissejuhatuses ei tegelda püstitatud ülesannete lahendamisega, seda ei kuhjata 

üle arvudega ning samuti ei ole üldjuhul vaja välja tuua teema valikuga seonduvaid isik-

likke motiive. Kui autor soovib töö valmimisega seoses kedagi tänada, on seda sobilik teha 

sissejuhatuse lõpus. 

 

Sissejuhatuse juures hinnatakse konkreetsust ja arusaadavust. Sissejuhatus viimistletakse 

töö vormistamisel koos kokkuvõttega viimasena. Valmis kirjutada tuleb see aga varem, 

sest sissejuhatus aitab mõista, mida tegelikult tegema hakatakse. Sissejuhatuses esitatud 

tsiteeritud ja refereeritud väited peavad olema korrektselt viidatud. Sissejuhatust pea-

tükina ei nummerdata. Iga kirjatöö sissejuhatuse maht peab olema proportsioonis selle töö 
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mahuga. Uurimistöö sissejuhatus on ca 1–2 A4 pikk. Sissejuhatus algab sisukorra (ja kasu-

tatud lühendite loetelu) järel uuelt lehelt (Insert→Page Break). 

 

5.5. Töö põhiosa 

 

Uurimistöö põhiosa algab uuelt lehelt (Insert→Page Break) ning on töö kõige mahukam 

ja väärtuslikum osa. Uurimistöö sisulises osas antakse vastused sissejuhatuses tõstatatud 

küsimustele. Üldjuhul on töös eristatud kasutatud kirjandusel põhinev teoreetiline osa 

ning autori uurimus, kuid spetsiifiliste uurimistööde puhul võib töö ülesehitus olla ka 

erinev. Seega, uurimistöö on soovitav üles ehitada kolmeosalisena: 

1) A n al üü t i l i n e  ü l ev aad e  t e em ako h as es t  k i r j and us e s t  j a  p ro b l eemis t ,  

s t  m i da  t e i s ed  on  t e i nu d  ( r e f e ree r i n g )  – hõlmab probleemi käsitlust, uuri-

misala või uuritava objekti kirjeldust vms teoreetilise kirjanduse põhjal. Kirjanduse 

ülevaates toodud faktid ja seisukohad peavad olema korrektselt viidatud (vt viitamine 

ptk 6.3). Reegel on, et üldteada fakte, nagu „Eesti gümnaasiumites õpetatakse muu-

hulgas bioloogiat, keemiat ja füüsikat”, ei ole vaja viidata, aga keemia õppekavas sisal-

duva väljatoomine nõuab juba viidet riiklikule õppekavale. 

2) M eto do l oo g i l i n e  os a ,  s t  mid a  mi n a  t eg in  ( u u r im us )  – peatükk peab 

sisaldama nii kasutatud uurimismeetodite (andmekogumis- ja andmetöötlusmeetodite) 

kirjeldust ja põhjendust kui kogutud materjalide, intervjueeritud isikute, uuritava objek-

ti, mudeli, katseseadme vms tutvustust ja valimi moodustamise põhimõtet. Nii näiteks 

esitatakse küsitluse korral küsitlevate valiku põhimõtted, küsitletute arv ja sooline, 

vanuseline vms jaotumine ning küsitluse läbiviimise aeg. Küsitlusleht esitatakse lisas, 

millele viidatakse ka töö põhiosas. Samuti tutvustatakse statistilisi meetodeid või 

programme, mida rakendatakse andmete töötlemisel. Eksperimentaalsete tööde korral 

tuleb esitada ka andmete usaldusväärsuse hinnang. See, kui täpselt tuleb metoodika 

lahti kirjutada, sõltub metoodika tuntusest ning erialast. Siinkohal tuleks nõu küsida 

juhendajalt. 

3) U u r i mu se  k ä i gus  s aad ud  l ahend us ed  j a  t u l emu s ed ,  s t  minu  j a  t e i s t e  

t eh tu  võ r d l us  (u u r im us e  ko kk uv õ t e  j a  j ä r e l du sed ;  t eoo r i a  j a  p r ak -

t ik a  v õ rd l us )  – tulemused esitatakse koos tõlgendusega. See tähendab, et alapea-

tükkide kaupa tuuakse välja materjali analüüsist tulenevad konkreetsed tulemused ning 

seejärel kõrvutatakse neid varem kirjanduses esitatud andmete või seisukohtadega. 
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Arutluses peavad selguma töö autori arvamused ja seisukohad uurimistulemuste kohta. 

Tulemuste (ala)peatükk lõpeb tööst tehtud järelduste väljatoomisega. 

 

Töö põhiosa liigendatakse teemast ja analüüsitud materjalist tulenevalt sobivateks pea-

tükkideks ning alapeatükkideks. Tuleb jälgida, et iga lõik oleks sisuline tervik ja et ei 

esineks lühikesi, paarist lõigust koosnevaid peatükke ega ühest lausest koosnevaid lõike. 

Kõik peatükid algavad uuelt lehelt (Insert→Page Break), alapeatükid aga üldjuhul mitte. 

Liiga lühikesed alapeatükid tuleb pikematega ühte siduda. Peatüki (ka alapeatüki) pealkirja 

ja sellele järgneva teksti vahele jäetakse üks tühi rida. Pealkirja ja eelneva teksti vahele on 

soovitav jätta kaks tühja rida. Kui kasutatakse alapeatükke, siis peab neid olema vähemalt 

kaks. Ei ole soovitav kasutada pikemaid kui kolmeosalisi peatükkide jaotusi (st 1, 1.1., 

1.1.1. on lubatud). 

 

* T32K õpilase uurimistöö põhiosa mahuks on 15−25 sisulehekülge (alates sissejuhatuse 

lõpust kuni kokkuvõtte alguseni). See tähendab, et siinkohal arvestatakse ainult sisupea-

tükke, mille hulka ei kuulu tiitelleht, sisukord, kasutatud lühendite loetelu, sissejuhatus, 

kokkuvõte, kasutatud kirjanduse ülevaade, resümeed ega lisad. 

 

5.6. Kokkuvõte 

 

Kokkuvõte algab lühikese kirjeldusega, kuidas sissejuhatuses püstitatud probleemi uuriti. 

Seejärel võetakse saadud tulemused eelnevalt sõnastatud eesmärkide kaupa kokku ning 

tuuakse välja tööst tehtud järeldused ja hinnangud. Samuti põhjendatakse, kas ja miks 

püstitatud hüpotees(id) leidsid kinnitust või mitte. Kokkuvõtte lõpus tuuakse välja nii töö 

koostamisel esinenud raskused kui töös üles kerkinud küsimused ja ettepanekud edasiseks 

uurimistööks. Samuti pakutakse võimalusi praktilise olukorra muutmiseks uuritavas vald-

konnas. Kõik kokkuvõttes kirjeldatu peab olema eelnevalt töös käsitletud. Seega, 

kokkuvõttes ei püstitata uusi probleeme, ei esitata seisukohti ega järeldusi küsimustes, 

mida töö varasemates osades pole käsitletud. 

 

Kaval on jälgida sissejuhatuse ja kokkuvõtte loogilist sobivust, sest need peaksid moodus-

tama omaette terviku. Hea kokkuvõte võimaldab lugejal põhiteksti vahele jättes ikkagi aru 

saada, mida töös on käsitletud ning milliste tulemuste ja järeldusteni jõuti. Kokkuvõttes ei 
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viidata kirjandusallikatele ega esitata arvandmeid, tabeleid ja teistelt autoritelt päri-

nevaid seisukohti ja järeldusi. Kokkuvõte algab uuelt lehelt (Insert→Page Break) ja seda 

peatükina ei nummerdata, pikkus ei ole üldjuhul rohkem kui 2 A4. 

 

5.7. Kasutatud kirjandus 

 

Kasutatud kirjanduses loetletakse töö koostamisel kasutatud ja viidatud allikad. Need 

tuuakse välja autorite perekonnanimede tähestikulises järjekorras, kusjuures ühe autori 

tööd reastatakse ilmumisaasta järgi. Kui autorit ei ole raamatukaanel ega tiitellehel näida-

tud, paigutatakse allikas kirjanduse loetellu tema pealkirja esimese sõna järgi. Pealkirjades 

ei kasutata siinkohal aga lühendeid ega jutumärke. 

 

Uurimistöö vormistamisel on oluline jälgida, et kõik tekstis esinevad viited oleksid kasu-

tatud kirjanduse loetelus välja toodud. Samuti peaks töö valmimisel üle vaatama, kas kõiki 

loetletud allikaid on ikka lõpptekstis viidatud, vastasel juhul ei saa allikat kasutatud kir-

janduse loetellu lisada. 

 

Kasutatud kirjanduse loetelu algab uuelt lehelt (Insert→Page Break) ja seda peatükina ei 

nummerdata. Viitamise ja kasutatud kirjanduse loetelu vormistamise nõuded on toodud 

käesolevas juhendis uurimistöö vormistamise all peatükkides 6.3 ja 6.5. 

 

5.8. Eestikeelne ja võõrkeelne resümee 

 

Resümee on uurimistöö lühikokkuvõte, mis on mõeldud eelkõige lugejale, kes ei valda 

keelt, milles töö on koostatud. Lisaks töö tulemustele ja järeldustele tuleb resümees välja 

tuua töö eesmärgid, nendeni jõudmise metoodika, töö ülesehituse tutvustus ja tehtud ette-

panekud. Seega on resümee süntees sissejuhatusest ja kokkuvõttest. Resümee kannab 

vastavakeelset töö pealkirja ja selle all vastavalt „Resümee“, „Summary”, „Zusammen-

fassung” vms. Resümee pikkus on üldjuhul 1−2 A4 ehk umbes 
1
/10 sisust. Resümee algab 

uuelt lehelt (Insert→ Page Break) pärast kasutatud kirjanduse loetelu ning seda peatükina 

ei nummerdata. Eesti- ja võõrkeelse resümee vormi annavad õpilasele tema eesti ja inglise 
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keele õpetajad. Siinse juhendi lisast 6 leiab ühe võimaliku viisi, kuidas võõrkeelset resü-

meed kirjutada. 

 

* T32K uurimistööle eestikeelse ja võõrkeelse resümee kirjutamisel on õpilasele abiks 

tema eesti keele ja inglise keele õpetaja, kelle pädevusse ei kuulu uurimistöö sisulise 

poole hindamine. Õpilane saab mõlema teksti eest arvestusliku hinde nii eesti kui inglise 

keele ainekursuse raames. 

 

5.9. Lisad 

 

Lisadesse paigutatakse selgitavad materjalid, mis on töö põhiosas esitamiseks liiga mahu-

kad ning raskendaksid töö lugemist (näiteks pikemad tabelid, joonised, loetelud, fotod, 

matemaatilised valemid, ankeedid, memuaarid, intervjuud, suuremahulised arvandmed, 

keeleuurimuses kasutatud sedelid, luuletused, mõõtmis- ja vaatlusprotokollid, suuremad 

plaanid, geograafilised kaardid, CD- või DVD-plaadid jms). Erineva sisuga materjal 

vormistatakse erinevate lisadena. Küll aga tuleb vältida uurimistöö tekstiga nõrgalt seotud 

lisade esitamist. 

 

Lisades esitatud joonised, tabelid, fotod jne allkirjastatakse, millest selgub ka materjalide 

päritolu (näiteks Autori erakogu; J. Tamme eraarhiivist jne). Kui uurimistöö juurde on 

lisatud CD- või DVD-plaate, tuleb plaadile kirjutada järgmised andmed: uurimistöö peal-

kiri ja autor, aasta ning mis andmed plaadil on. 

 

Lisad pealkirjastatakse ja tuuakse välja sisukorras. Rohkem kui ühe lisa korral peab 

need ka nummerdama vastavalt tekstis viitamise järjekorrale (näiteks Lisa 1: Küsitlus-

leht; Lisa 2: E-ajakirjade loetelu). Lisade pealkirjad esitatakse sisukorras järgmiselt: 

LISAD 

Lisa 1. Küsitlusleht 

Lisa 2. E-ajakirjade loetelu 

 

Iga lisa algab uuelt lehelt (Insert→Page Break). Lisad ja nende pealkirjad tuuakse välja ka 

sisukorras. Lisad paiknevad töös kõige lõpus, st pärast kasutatud kirjandust ja resümeesid. 
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6. UURIMISTÖÖ VORMISTAMINE 

 

Uurimistöö vormistamisel on oluline järgida just selles haridus- või teadusasutuses, kus 

tööd kaitsma hakatakse, kehtivaid vormistamisnõudeid. T32K-s valmivate uurimistööde 

vormistamise aluseks on käesolev juhend. Kindlasti on see sobilik ka teistes haridusasu-

tustes juhul, kui seal eraldi vormistamisjuhendit ei ole. Erinevatest uurimistööde konkurs-

sidest osa võttes tasub aga kindlasti uurida, kas konkursil on vormistamisnõuded eraldi 

välja toodud või mitte. 

 

6.1. Üldnõuded uurimistöö vormistamisel 

 

Uurimistöö esitatakse A4 (210x297 mm) formaadis valgetel lehtedel arvutikirjas. Lehe-

külje vasakusse serva jäetakse 3 cm, paremasse serva 2,5 cm ning üla- ja alaserva samuti 

2,5 cm laiune veeris (File→Page Setup). Kirjatüübiks on Times New Roman suurusega 12 

punkti. Reavahe on 1,5 punkti (v.a loendid, tabelid ja muud sarnased tekstiosad, kus võib 

kasutada 1,0-kordset reavahet). Taandrida ei kasutata, vaid tekstilõigu ette jäetakse kas tühi 

rida või täiendav 6-punktine vahe (Format→Paragraph→Spacing Before→6 pt). Tekst 

paigutatakse paberile rööpselt (Justify), püüdes seejuures vältida põhjendamatuid sõren-

dusi, järelikult tuleb vajadusel sõnu poolitada. Oluliste mõistete rõhutamiseks on lubatud 

kasutada paksu kirja (Bold), kursiivkirja (Italic) või sõrendust (Format→Font→ 

Character Spacing→Spacing →Expanded). Ühes ja samas kirjalikus töös ei ole soovitav 

kasutada mitut eri šrifti ega üksteisest tunduvalt erinevaid kirjasuurusi. 

 

Kõik leheküljed alates tiitellehest kuni lisadeni saavad leheküljenumbri, mis paigutatakse 

lehekülje alla keskele (Insert→Page Numbers→Position→Bottom of Page (Footer)→ 

Alignment→Center). Tiitellehel ega tiitellehe pöördel leheküljenumbrit ei näidata (Diffrent 

First Page). Tiitellehe ning selle pöörde vormistamist käsitletakse käesoleva juhendi pea-

tükis 5.1 (vt näidiseid lisadest 3 ja 4). 

 

Nii sisupeatükid, nende alapeatükid kui lisad pealkirjastatakse. Kõikide peatükkide, sisse-

juhatuse, kokkuvõtte, kasutatud kirjanduse ja resümeede pealkirjad kirjutatakse läbivate 

suurtähtedega (Format→Font→All Caps). Alljaotuste pealkirjad (sh lisade pealkirjad) 

kirjutatakse väiketähtedega (v.a suur algustäht). Peatükkide ja teiste alljaotuste pealkirjade 
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järele punkti ei lisata. Erandiks on juhud, kus pealkiri koosneb mitmest lausest. Küsilau-

seid, hüüdlauseid ja ilukirjanduslikku stiili uurimistöö pealkirjades reeglina ei kasutata. 

Samuti ei kasutata pealkirjades lühendeid ega poolitata sõnu. Lehekülgede (v.a tiitellehe) 

paremasse ülaserva võib soovi korral kirjutada töö või vastava peatüki pealkirja (lubatud 

ka lühendatud kujul). 

 

Pealkirjade laadid tuleb määrata enne sisukorra loomist. Pealkirjadel on vasakjoondus 

(Align Left), reavaheks 1,5 ja kirjatüübiks on Times New Roman, mille suurus on peal-

kirjade hierarhiast tingituna erinev. Seega tuleb erineva taseme pealkirjad vormistada järg-

nevalt: 

 1. PEATÜKI PEALKIRI (Heading 1): 16 pt, Bold, läbivad suurtähed (All Caps); 

 1.1. Alapeatüki pealkiri (Heading 2): 14 pt, Bold, Italic, esisuurtäht; 

 1.1.1. Punkti pealkiri (Heading 3): 13 pt, Bold, esisuurtäht. 

 

Kui tekstiprogramm pakub pealkirjade vormistamisel muid sätteid (nt Heading 1 suuruseks 

12 pt ja kirjastiiliks Arial), siis muudetakse pealkirjade vormistust: Format→Styles and 

Formatting. Avanevas dialoogiaknas vasakul asuvast stiilide loetelust määratakse korri-

geeritav pealkiri (nt Heading 1) ja klõpsatakse nupule Modify. Uues dialoogiaknas nupule 

Format klõpsates avanevad erinevad menüüd, kus määratakse vastava taseme pealkirja 

sätted. Tehtud valikud kinnitatakse, klikkides OK. Alapeatüki ja punkti pealkirja korrigee-

rimine toimub analoogse skeemi järgi. Valikuid ei tohi unustada kinnitada klikkidega OK 

ja lõpuks dialoogiaknas Style klõps Apply. 

 

Kõikide töö iseseisvate osade, st sissejuhatuse, sisupeatükkide, kokkuvõtte, kasutatud kir-

janduse, resümeede ja lisa pealkirjad vormistatakse esimese astme pealkirjadena, s.o stiilis 

Heading 1. Nummerdatakse vaid töö põhiosa ehk sisupeatükid. Tuleb meeles pidada, et 

kõik, mis on trükitud Heading-stiilis, korjatakse hiljem sisukorda (Table of Contents). See-

pärast tasub hoiduda pealkirjade stiili kasutamist muuks otstarbeks, näiteks tiitellehe 

vormistamiseks. Ka pealkiri „Sisukord” on soovitav sisestada stiilis Normal, kuid sama 

kujuga kui Heading 1. Sisukorra koostamisest ja vormistamisest on juttu antud juhendi 

peatükis 5.2. 

 

Uurimistöö sisupeatükid ja alapeatükid nummerdatakse araabia numbritega (näiteks 1., 

2., 3. ja 1.1., 1.2. jne). Numbrite vahel ja lõpus on punkt, kuid tekstis osutamisel lõpus 
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punkti ei ole (näiteks punkti 3.2.2 kohaselt). Et peatükki liigendada alapeatükkideks, peab 

viimaseid olema vähemalt kaks. Samuti, kui lisasid on rohkem kui üks, tuleb lisad num-

merdada araabia numbritega (näiteks Lisa 1, Lisa 2 jne). Kõigile lisadele tuleb töö sisu-

peatükkides ka viidata. Soovitav on kasutada kuni kolmetasandilist peatükkide hierar-

hia järjestussüsteemi. 

Näiteks: 

1. _________________________________  4 

1.1. ___________________________  7 

1.1.1. ____________________  7 

1.1.2. ____________________  9 

1.2. ___________________________ 11 

1.2.1. ____________________ 12 

1.2.2. ____________________ 13 

2. _________________________________ 15 

 

Kõiki peatükke ja töö iseseisvaid struktuuriüksusi (st sisukord, sissejuhatus, kokkuvõte, 

kasutatud kirjanduse loetelu, resümeed, lisad) alustatakse uuelt lehelt (Insert→Page 

Break). Alapeatükid järgnevad samalt leheküljelt. Kui pealkirjaga samale lehele ei mahu 

vähemalt kaks rida sellele järgnevat teksti, tuleks trükkimist alustada järgmiselt lehelt. 

Peatüki ja alapeatüki pealkirja ning sellele järgneva teksti vahele jäetakse kas üks tühi rida 

või täiendav 24-punktine lõiguvahe (Format→Paragraph→Spacing After→24 pt). Ala-

pealkirja ning sellele eelneva teksti vahele on soovitav jätta kas kaks tühja rida või samuti 

täiendav 24-punktine lõiguvahe. 

 

Töös kasutatud fotod allkirjastatakse: kes või mis on fotol, kes on foto jäädvustanud, kelle 

omanduses on originaal jms. Ühikute märkimisel on numbri ja sõna vahel tühik. Erandiks 

on protsendi- ja kraaditähiste kokkukirjutamine eesoleva arvuga (näiteks majanduskasv 

4,1%, kalle 8°). Ajavahemiku vms korral kirjutatakse ühik kas viimase arvu järele või 

esimese arvu ette (näiteks 16−75 aastat, aastatel 1990−2006). 

 

Uurimistöö esitatakse kas kiirköitjas või köidetult (kõvade kaantega või spiraalköites). 

Kõvade kaante vahele köidetud tööl peab nii ees kui taga olema puhas valge leht. 
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* T32K õpilane esitab uurimistöö kaitsmiskomisjonile paberkandjal kahes eksemplaris, 

millest ühe saab ta enne kaitsmist koos retsensendi kommentaaridega tagasi. Samuti tuleb 

õpilasel esitada oma uurimistöö digitaalne variant (pdf-formaadis), mis lisatakse T32K 

uurimistööde elektroonsesse arhiivi. 

 

6.2. Uurimistöö keeleline vormistus 

 

Uurimistöö tuleb vormistada korrektses eesti keeles. Töö peab moodustama terviku, kus 

antakse edasi kõik uurimistöö seisukohast vajalik. Töö korrektne vormistus eeldab veatut 

kirjakeelt, selget ja täpset sõnastust. Lubamatud on trükivead. 

 

Teadusteksti stiil on tavaliselt neutraalne, emotsioonideta ja impersonaalne. Seega vormis-

tatakse uurimistöö kindlas kõneviisis ja kas umbisikulises vormis (nt tehti, uuriti, järeldati, 

võrreldi), mina-vormis (nt tegin, uurisin, järeldasin, võrdlesin) või meie-vormis (nt tegime, 

uurisime, järeldasime, võrdlesime). Neist esimene variant on kõige enam ja viimane kõige 

vähem levinud. Igal juhul peab vorm olema kogu töös ühtne. 

Näiteväljendeid: 

Käesolevas töös antakse ülevaade… 

Teises peatükis analüüsitakse… 

Sedeldatud materjal on kogutud… 

Näidetest järeldub, et… 

Joonise 1 andmed osutavad, et… 

Küsitlusest võib järeldada, et… 

Vältida tuleb nn konspektistiili (elliptilised laused, pelgalt võtmesõnadega laused, rohked 

lühendid), kõnekeelt, slängi, käibe- ja poeetilisi fraase (nt kellel on õnnestunud röntgeni 

järjekorras elama jääda, on meeldiv võimalus surra operatsiooni enda järjekorras), võõr-

sõnadega liialdamist, paljusõnalisi, kuid sisutühje lauseid. Samuti tuleb vältida (üli)emot-

sionaalsete omadussõnade tarvitamist (nt majanduslik olukord on lausa suurepärane; 

hinnad tõusid maru kiiresti). Kõikidest kasutusele võetud terminitest, lühenditest ja sümbo-

litest tuleb kogu töö ulatuses kinni pidada. 

 

Võõrkeelsest kirjandusest materjali tõlkimisel peab kindlasti jälgima lauseehitust ja püüd-

ma vältida liiga pikki lauseid. Tõlkida tuleb lause mõtet, mitte üksikuid sõnu. Võõrkeelsest 
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kirjandusest refereeritud mõiste, mille tähendus ei ole eesti keeles kõigi jaoks üheselt tun-

tud, tuleb töös esimest korda mainides sulgudes kursiivkirjas (Italic) ka originaalkeeles 

välja tuua (näiteks „Enesetõhusus (self-efficacy) on tugevalt seotud õpitulemustega“). 

 

Ühekohalised arvud on soovitav kirjutada sõnadega, ülejäänud arvud numbritega (nt kaks 

punkti, kaheksa tööpäeva, 120 ettevõtet). Kui aga ühekohalisele arvule järgneb mõõtühik 

või tähis, siis kirjutatakse ta numbriga (nt 30% vastanuist). Käändelõppe arvudele hari-

likult ei lisata (nt 7 õpilasele, 39 vastanust). Järgarvu järele pannakse punkt (nt 10. klassis, 

2010. aastal). Aastad tuleks märkida arvuliselt, mitte eelmisel aastal ega käesoleval aastal. 

Nii tekstis kui tabelites peaks loobuma rohkema kui 3–4 tüvenumbriga arvude kasuta-

misest. Suurte arvude korral on soovitav kasutada kombineeritud kirjutusviisi, mille puhul 

arv on märgitud numbri(te)ga ja suurusjärk sõnadega (nt 1,42 milj elanikku). Lauset ei 

alustata numbriga, vaid sõnaga. 

 

NB! Tuleb eristada kriipse: - on sidekriips ning – on kuni-kriips ja mõttekriips. 

 

Kui töö on valminud, tuleb see kindlasti paar korda läbi lugeda. Kirja- ja sõnastusvigade 

avastamiseks on kasulik lasta tööd lugeda mõnel kolmandal isikul. 

 

6.3. Viitamine 

 

Kõigile töös kirja pandud seisukohtadele, faktidele ja andmetele, mis ei ole autori 

enda poolt välja mõeldud, tuleb viidata! Mööndus tehakse siin kõigile üldtuntud fakti-

dele, kuid siiski on parem pigem rohkem viidata, kui üldse viitamata jätta. Võõraste mõtete 

esitamist enda omadena käsitletakse plagiaadina. Hea toon näeb ette, et uurimistöös viida-

takse teaduslikule või vähemalt teaduslikkusele pretendeerivale kirjandusele. Uurimistöös 

ei viidata ajaviiteajakirjade artiklitele ega populaarteaduslikele raamatutele, kui see ei ole 

uurimistöö teema seisukohalt vajalik. Kõige lihtsamini saab teaduslikul ja mitteteaduslikul 

kirjatükil vahet teha selle järgi, kas tekstis esinevad viited või mitte. Uurimistöös tuleks 

kasutada allikaid, kus esinevad viited. Eranditeks on viited arhiivimaterjalidele, sõna-

raamatutele, intervjuudele, arvamustele ja teistele originaalallikatele, aga ka eelpool nime-

tatud mitteteaduslikele tekstidele, kui viimased on osa uurimistöö teemast (näiteks, kui 

uuritakse kooliõpilaste probleemide kajastamist peredele suunatud ajakirjades). 
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Viitamistehnikaid on mitmeid. Järgnevalt on välja toodud T32K-s aktsepteeritud viisid. 

Oluline on, et kogu uurimistöös viidataks ühesuguse süsteemi alusel! Kasutatud kirjan-

duse loetelu (vt ptk 6.5) koostatakse mõlema viitamissüsteemi puhul tavaliselt autorite 

perekonnanimede tähestikulises järjekorras. 

 

6.3.1. Viitamine autori nime ja aastaarvuga 

 

Teistele autoritele kuuluvaid seisukohti või andmeid võib uurimistöös esitada tsitaatidena 

või refereeringutena. Tsitaat on sõnasõnaline väljavõte viidatava kirjatüki tekstist. Tsitaa-

tidena tuuakse välja eriti ilmekad või huvitavad mõtted või näited. Tsitaate võib lühendada 

või katkestada, seejuures tuleb väljajäetav koht kindlasti tähistada märgiga (…) või (---). 

Lühendus ega väljajätt ei tohi muuta originaalteksti mõtet. Tsitaat peab vastama originaa-

lile sõnastuse, ortograafia, kirjavahemärkide ja eristuskirjade (sõrendused jm) osas. Tsitee-

rimisel võõrkeeltest tuleb tsitaat eesti keelde tõlkida võimalikult adekvaatselt, vajadusel 

esitatakse originaalsõnastus joonealusena. Tsitaat peab olema jutumärkides ning lõppema 

ümarsulgudes oleva viitega. Kui tsitaat koosneb ühest lausest, pannakse punkt pärast viite 

lõpusulgu. Kui tsitaat koosneb mitmest lausest, siis paikneb viide pärast jutumärke viimase 

lause järel, kusjuures punkti viite lõpusulu järel ei panda. Viites kajastub autori perekonna-

nimi, teose ilmumisaasta ja viidatud leheküljenumbrid (kui pole leheküljenumbrit, siis 

ilma). Pööra tähelepanu kooloni asukohale ja tühikutele! 

Näiteks: „Ebaturvalises ja raskesti ennustatava tulevikuga ühiskonnas võivad küll 

tekkida ühekordsed protestiaktsioonid (…), aga mitte kodanikeühiskonda, mis oleks 

võimeline kaitsma turvalisust kui ühishüve” (Lagerpetz 2005: 4). 

Näiteks: „Te olete käinud ära tee ussikesest inimeseni, aga palju on teis veel ussikest. 

Kord olite ahvid, aga praegugi veel on inimene ahvem kui ükski ahv.“ (Nietzsche 

1993: 7) 

 

Peamine viis teoreetilistele allikatele viidata on refereeringuna. Sellisel juhul võetakse 

teise autori mõte kokku või jutustatakse ümber oma sõnadega. Refereeringu puhul ei kasu-

tata jutumärke, kuid tekstist peab olema selgelt nähtav, kust refereering algab ja kus lõpeb. 

Viitamine toimub teksti sees ja viide pannakse refereeringu lõppu. Kui refereering koosneb 

ühest lausest, siis paikneb viide enne lauset lõpetavat punkti, kui aga mitmest lausest või 

tervest lõigust, siis pärast punkti, kusjuures punkti viite lõpusulu järel ei panda. Viites 
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kajastub autori perekonnanimi, teose ilmumisaasta ja viidatud leheküljenumbrid (kui pole 

leheküljenumbrit, siis ilma). Pööra siingi tähelepanu koolonile ja tühikutele! 

Näiteks: Edu saavutamisele suunatud eesmärkidega õppija soovib näidata oma häid 

võimeid ja oskusi ning tõestada enda võimekust võrreldes teistega (Covington, 2000: 

23). Õppimise protsessi asemel keskenduvad edu saavutamisele suunatud inimesed 

pigem õppimise tulemusele (Eppler, Harju 1997: 109). 

Pikema refereeriva tekstilõigu või loetelu puhul on soovitav kasutada selle alguses 

tekstisisest viidet ehk lihtsalt selgitavat lauset. Sellisel juhul ei ole refereeringu lõpus uut 

viitesulgu vaja esitada, samuti pole tekstis mainitud autori nime vaja viitesulus korrata, 

kuid refereeringu ja järgneva teksti piir peab olema üheselt mõistetav. 

Näiteks: Kirjandi ülesehitust on põhjalikult käsitlenud professor Martin Ehala õpikus 

„Kirjutamise kunst” (2000: 78-79). 

Mitut allikat korraga refreerides esitatakse nende viited kõik ühes ja samas viites, kus-

juures omavahel eraldatakse nad semikooloniga ning viited järjestatakse kronoloogiliselt. 

Näiteks: Mitmed uurimused (Johnson 1979; Deutsch 1980; Morton 1985) viitavad 

kooperatiivse õppemeetodi kasutamisega kaasnevale olulisele õppeedukuse kasvule. 

 

Kui viidataval kirjatükil on rohkem kui kaks autorit, tuuakse esimese kuue autori pere-

konnanimed välja ainult esimeses viites. Edaspidi kasutatakse esimese autori nime ja tähis-

tust jt või et al (ladina keelest et alii – ’ja teised’). 

Näiteks: Demograafilised muutused ei sõltu ühiskonna muutustest (Jänes jt 2005: 45 

VÕI Jänes et al 2005: 45). 

Juhul, kui refereeritava autori nimi on osa tekstist, lisatakse ilmumisaasta ja lehekülje-

number nime järele sulgudesse. 

Näiteks: Eppleri ja Harju (1997: 109) arvates keskenduvad edu saavutamisele suuna-

tud inimesed peamiselt õppimise tulemusele. Jänes jt (2005: 45) on öelnud, et demo-

graafilised muutused ei sõltu ühiskonna muutustest. 

Juhul kui autorit pole märgitud (kusjuures tiitellehel märgitud koostajad ega toimetajad 

ei ole töö autorid), tuuakse viites trükise pealkirja esimesed sõnad ja kolm punkti või peal-

kirja suurtähtlühend, ilmumisaasta ja viidatud leheküljenumbrid. Sama nõue kehtib ka 

sarnastele internetimaterjalidele, mille viitesse leheküljenumbrit üldjuhul lisada ei saa. 

Näiteks: „Rumaluse esimene aste on pidada end targaks“ (Tsitaadiraamat...2001: 

235). Kreeka tragöödiakirjanik Sophokles on öelnud: „Kõige teravamat valu teeb 

mõistmine, et kõigi meie hädade põhjuseks oleme me ise” (KASM 2001: 21). 
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Näiteks: Hindamismudelite loomine on raske, kuid kasutamine kerge (Creating 

Rubrics… 2006). 

Kui viidatakse ilma pealkirja ja autorita internetimaterjalile, siis märgitakse viitesse 

veebilehe nimetus või teksti pealkiri (mitte aga veebilink!). 

Näiteks: Eesti Draamateatri teatrijuht on Rein Oja (Eesti Draamateatri kodulehekülg 

2010). 

Kui viidatakse mitmele sama autori samal aastal ilmunud tööle, tuleb aastaarvud tähis-

tada märgetega a, b, c (nt Covington 2000a; Covington 2000b). Sama tähistust tuleb kasu-

tada ka kasutatud kirjanduse loetelus (vt ptk 6.5). 

 

Juhul, kui ühele ja samale allikale viidatakse ühel ja samal leheküljel mitu korda, on 

soovitav pärast allika esimest viidet kasutada lühendit Ibid (ladina keelest ibidem – ’samas 

kohas’) koos lehekülgede äranäitamisega (nt Ibid.: 22). 

 

Entsüklopeediale või sõnaraamatule viidates märgitakse selle teose nimi või lühend, 

ilmumisaasta ja viide märksõnale koos lühendiga sub (ladina keelest sub – ’all’). 

Näiteks: Kunst on maailma esteetilise hõlvamise viis, milles avaldub inimese üldine 

loomejõud (EE5 1990, sub kunst). 

Näiteks: Füüsika on õppeaine, milles õpetatakse füüsika teaduse alg- ja põhiteadmisi 

(Vikipeedia 2010, sub füüsika). 

 

Internetimaterjalidele viitamisel tuleb järgida raamatutele viitamise põhimõtet: esitada 

autor ja avaldamisaasta. Autori andmete puudumisel on põhiliseks viitamisaluseks teksti 

pealkiri või veebilehe nimetus, mitte aga internetiaadress! 

Näiteks: „Püha Jüri on sõjameeste, maaharijate ja süütute neitsite kaitsepühak” 

(Kaeval 2003). 

* Sellisel puhul on kasutatud kirjanduse loetelus järgmine kirje: 

Kaeval, Kait 2003. Tori kirikuaeda paigaldati ratsamonument. – e-Kaldad, 10. 

september; http://kaldad.kolhoos.ee/stories/storyReader$104 (17.05.2011) 

Näiteks: „Riigieksamitele registreerimise tähtaeg on 20. jaanuar 2011“ (Varem-

lõpetanute… 2011). 

* Selle näite kohta on kasutatud kirjanduse loetelus järgmine kirje: 

http://kaldad.kolhoos.ee/stories/storyReader$104


35 

 

Varemlõpetanute… = Varemlõpetanute registreerumine riigieksamitele 2011. – 

Riiklik Eksami- ja Kvalifikatsioonikeskus; http://www.ekk.edu.ee/oppurile/riigi-

eksamiinfo-varemlopetanutele (17.05.2011) 

 

Kaudviitamine ehk viitamine mõnele autorile teise autori teose kaudu on üldiselt taunitav, 

võimalusel tuleb katsuda kätte saada siiski originaalteos. Kui see kuidagi ei õnnestu, kasu-

tatakse erandkorras kaudviitamist – viidatakse nii originaalteosele, aga märgitakse ära ka 

reaalne kasutatud allikas. 

Näiteks: Oma mälestusteraamatus on Henno Käo seda kirjeldanud järgmiselt: „Mu 

tolleaegses elukohas läks läbiotsijatel kähku, sest pideva kolimise tõttu polnud seda 

va nodi veel suurt koguneda jõudnud – ainult väike riiulitäis raamatuid ja mõned 

hilbud” (1999, viidatud Salumets 2001 järgi). 

 

6.3.2. Joonealune viitamine 

 

Teine võimalus on viidata joonealuselt. Sellisel juhul märgitakse tsitaadi või refereeringu 

lõppu viite number ülaindeksina (Insert→Symbol või trükitud number aktiivseks teha ja 

siis käsklused Format→Font→Superscript). 

Näiteks: Kreeka tragöödiakirjanik Sophokles on öelnud: „Kõige teravamat valu teeb 

mõistmine, et kõigi meie hädade põhjuseks oleme me ise”.
1
 

Tavaliselt kasutatakse viidete numeratsiooni läbivalt kogu töö, kuid võib alustada viidete 

uut numeratsiooni ka igal leheküljel. Viidatava kirjatüki andmed tuuakse välja samal lehe-

küljel joonealuse kirjena, mis algab ülaindeksina trükitud viitenumbriga. Viitekirjed võib 

vormistada samamoodi nagu kasutatud kirjanduse loetelus (vt ptk 6.5). 

 

Joonealuse viitamise eeliseks on võimalus leida kogu bibliograafiline andmestik teksti-

viitega samalt leheküljelt, samas võtab joonealune viitamine enda alla asjatult palju ruumi. 

Sellist süsteemi kasutatakse sageli kirjandusloo- ja eriti ajalooalastes töödes, kus joone-

alustele allikakirjetele on autoril mõnikord vaja lisada omapoolseid märkusi. 

 

 

 

http://www.ekk.edu.ee/oppurile/riigi%1feksamiinfo-varemlopetanutele
http://www.ekk.edu.ee/oppurile/riigi%1feksamiinfo-varemlopetanutele
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6.4. Tabelite ja joonisete ning valemite ja loetelude vormistamine 

 

Tabelid ja joonised võimaldavad esitada süstematiseeritult ja ülevaatlikult arvandmeid ning 

seoseid või illustreerida teksti. 

 

Tabelid. Iga tabel on nummerdatud araabia numbritega (näiteks Tabel 1, Tabel 2 jne) ning 

varustatud pealkirjaga, mis paikneb tabeli peal ja mille järel punkti ei ole. Tabelite numb-

reid hakatakse lugema alates esimesest tabelist. Tabeli pealkiri peab olema võimalikult 

lühike ja selge, kuid samas mõtestama tabeli sisu lahti ka antud tööd mittelugenud inime-

sele. Tabelile peab olema uurimistöö sisus viidatud kas otseselt (nt Alljärgnev tabel 1 

iseloomustab...) või kaudselt (näiteks (vt tabel 1). Peale viidet peab töös kas kohe või 

järgmisel leheküljel järgnema tabel. Juhul kui tabeli pikkus ei ületa ühte lehekülge, kuid 

peale viidet kogu tabel antud leheküljele enam ei mahu, on soovitav tabelit alustada järg-

misel leheküljel. Kui aga tabel on pikem kui üks lehekülg, siis tuleb see paigutada uurimis-

töö lisasse. 

 

Tabelis esitatud andmed peavad olema ühemõtteliselt tõlgendatavad ning tabel peab olema 

loetav ka põhiteksti süvenemata. Tabeli veergudel ja ridadel peavad olema nimetused, mis 

on andmetest eraldatud. Tabelite kujundus olgu kogu töös ühtne (Times New Roman, 

kirjasuurus 12 või 11, reavahe 1,0). 

 

Tabel 1. Uurimuses osalenud õpilaste jagunemine klassiti ja sooti 

 2. klass 3. klass 4. klass 5. klass 6. klass 

Poisid 45 97 134 89 37 

Tüdrukud 49 91 140 91 49 

K o k k u  94 188 274 180 86 

 

Kui kõigi tabelis toodud andmete kohta saab kasutada ühesugust mõõtühikut, siis tuuakse 

see ära tabeli pealkirja järel sulgudes tavalises kirjas. Mitme mõõtühiku kasutamisel esita-

takse need vastavate veergude või ridade nimetuste juures ilma sulgudeta, eraldades nad 

eelnevast tekstist komaga. 
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Joonised. Joonisteks nimetatakse kõiki teisi illustratiivse väärtusega materjale, nagu pildid, 

skeemid, graafikud, diagrammid, joonistused, fotod, geograafilised kaardid jne. Joonised 

on sarnaselt tabelitele nummerdatud araabia numbritega (näiteks Joonis 1, Joonis 2 jne) ja 

varustatud lakooniliste pealkirjadega, mille järele punkti ei panda. Joonistelegi tuleb tekstis 

viidata (nt Joonis 1 kirjeldab... või (vt joonis 1)). Tabelitest erinevad joonised aga selles, et 

joonise pealkiri asub joonise all. Sarnaselt tabelitele peab ka jooniste puhul jälgima, et nad 

oleksid üheselt mõistetavad ning annaks tõepoolest edasi olulist informatsiooni. 
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Joonis 1. Põhikooli lõpus osaoskuste testi kirjutanud õpilaste arv 

 

Joonisele kantavad tähised, arvud ja sõnaline tekst tuleb trükkida suurusega 11 punkti 

stiilis Times New Roman ja reavahega 1,0. Samuti tuleb vajadusel nende tähendust selgi-

tada kas joonise väljal või tekstis joonise juures (nt Joonisel 5 kajastab punkt A situat-

siooni, kus toodangu maht q tagab minimaalse piirkulu PK). Väikeste mõõtmetega joonis 

paikneb teksti vahel sobivas kohas, suurem joonis eraldi lehel pärast viidet. Kui joonis pole 

autori enda koostatud, siis tuleb analoogselt tabelitega märkida sulgudesse viide joonise 

allikale. 

 

Nii joonised kui tabelid paigutatakse uurimistöös võimalikult lähedale tekstile, kus neid 

esmakordselt viidatakse. Mahukamad tabelid ja joonised, mille esitamata jätmine töö põhi-

osas ei vähenda töö selgust, on mõistlik panna töö lisadesse. Üksikuid arvandmeid ei ole 

mõtet tabelisse paigutada, parem on need esitada teksti sees. 

Näiteks: Uurimuses osalejatest olid 51% poisid ja 49% tüdrukud. 
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Valemid eraldatakse muust tekstist kirjavahemärkidega, mis vastavad üldistele eesti keele 

reeglitele. Kõik märgid, arvud ja tähed tuleb paigutada valemis korrektselt ning kooskõlas 

valemi sisuga. Valemite vormistamiseks tuleb kasutada valemiredaktorit. Kogu uurimistöö 

ulatuses tuleb silmas pidada valemite ühtset kirjaviisi. Valemid kirjutatakse kaldkirjas 

(Italic) suurusega 12 kirjapunkti kirjastiiliks TimesNewRoman. 

Näiteks: a
2 

+ b
2
 = c

2 

 

Definitsioonide esitamist valemi kujul tuleb vältida. Üksikud sümbolid ja lihtsad mate-

maatilised avaldised esitatakse reeglina teksti sees omaette reale viimata. Võrdust ja võrra-

tust väljendavad avaldised esitatakse tavaliselt aga omaette real. Kui töös on mitu valemit, 

tasub need nummerdada. Valemi number paigutatakse sulgudesse valemiga samale reale 

(soovitavalt paremale). Valemites ei tooda mõõtühikuid, vaid need esitatakse valemites 

kasutatud sümbolite seletustes. Valemi sümbolite seletus algab sõnaga kus (ilma järgneva 

koolonita) ning seletused kirjutatakse ülevaatlikkuse mõttes üksteise alla. 

Näiteks: 

Tarbimise eelarvepiirang avaldub: 

n 

∑ pi xi < c      (1) 

i = 1 

kus pi – hüvise hind (kroonides), 

xi – hüvise kogus (tk), 

n – hüviste arv, 

c – tarbimiseelarve (kroonides). 

 

Loetelude koostamisel tuleb silmas pidada mitmeid nõudeid. Kui loetelu koosneb üksi-

kutest sõnadest või lühikestest fraasidest, kirjutatakse loetelu punktid üksteise järele ja 

eraldatakse komaga. Kui kas või üks loetelu punktidest sisaldab koma(sid), tuleb eraldus-

märgina kasutada semikoolonit. Järjekorda tähistatakse ümarsulgudega varustatud numb-

rite või tähtedega. 

Näiteks: Eesti kalad on lest, luts, kilu, räim. 

Eesti kalad on: 1) lest, 2) luts, 3) kilu, 4) räim. 

Eesti kalad on: a) lest, b) luts, c) kilu, d) räim. 
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Kui loetelu punktideks on üksikud laused, siis võib need kirjutada üksteise järele või alus-

tada iga lauset uuest reast. Numbri või tähe järel on ümarsulg, alustatakse väiketähega ja 

laused eraldatakse üksteisest semikooloniga. 

Näiteks: Turule pääsemine on lihtne järgmistel juhtudel: 

1) turg on piisavalt suur, 

2) positsioon sobib täpselt sellele firmale. 

Turule pääsemine on lihtne järgmistel juhtudel: 

a) turg on piisavalt suur, 

b) positsioon sobib täpselt sellele firmale. 

Kui kas või üks loetelu punktidest koosneb kahest või enamast lausest, siis asendatakse 

sulg järjekorranumbri järel punktiga. Kui mõni loetelu punkt sisaldab omakorda loetelu, 

siis tähistatakse üldisema loetelu punktide järjekorda tingimata numbritega, alluva loetelu 

punkte aga tähtedega (koos suluga). 

Näiteks: Teooria all mõistetakse definitsioonide, eelduste ja hüpoteeside süsteemi. 

Teooriaid võib jaotada järgmiselt: 

1. Klassifitseerivad teooriad selgitavad majanduslikke realiteete mõistete defi-

neerimise kaudu. 

2. Nomoloogilised teooriad on suunatud protsesside sisemiste seaduspärasuste 

avastamisele. 

3. Otsustusteooriad käsitlevad teatud inimkäitumise viise. 

Sealjuures võib neid jagada: 

a) deskriptiivseteks, 

b) preskriptiivseteks. 

 

Loetelus kasutatakse nummerdamist tavaliselt siis, kui on oluline nende järjekord või arv, 

kui tekstis mõnele neist viidatakse või kui loetelu punktid koosnevad mitmest lausest. 

Muudel juhtudel võib järjekorra tähistuse, st numbrid või tähed, ära jätta või asendada 

mõttekriipsuga, kui loetelu punktid on eelneva teksti otseseks jätkuks, või mõne muu tähis-

tusega. 

Näiteks: Bürokraatiale iseloomulikud tunnused on: 

− isiklik vabadus, 

− kindla teenistushierarhia olemasolu, 

− selgelt määratletud teenistuslik kompetents. 
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Näiteks: Käitumusliku hindamisskaala meetodite alaliikidena leiavad rakendamist: 

• käitumisootuste skaala meetod, 

• käitumisvaatluste skaala meetod, 

• kontrollväidete meetod, 

• ühesuunaliste käitumisviiside meetod. 

 

Silmas tuleb pidada, et erinevalt vormistatud loetelud annavad edasi erinevat sisu ning et 

kirjavahemärgid ei oleks vastuolus eesti keele grammatika reeglitega. Loetelu igal tasandil 

peab olema vähemalt kaks alapunkti. Kogu töö ulatuses tuleks kasutada ühtset loetelude 

esitust ning vältida liiga paljude erinevate stiilide kasutamist. 

 

6.5. Kasutatud kirjanduse loetelu vormistamine 

 

Kasutatud kirjanduse loetelu uurimistöö lõpus hõlmab endas kõiki töös viidatud allikaid. 

Materjali, mille autor uurimistöö koostamisel küll läbi töötas, kuid mida töös ei ole tsi-

teeritud ega refereeritud, kirjanduse loetellu lisada ei saa! Kasutatud kirjandus esitatakse 

loetelus autorite perekonnanimede tähestikulises järjekorras. Kõigepealt loetletakse 

ladinatähestikulised allikad, seejärel kreeka- ja slaavitähestikulised. Venekeelsetes töödes 

on kasutatud kirjanduse paigutus vastupidine. 

 

Kui loetelus on ühelt autorilt mitu tööd, siis järjestatakse need ilmumisaastate järgi. Ühel 

aastal samalt autorilt ilmunud tööd eristatakse tähtedega a, b, d jne, mis lisatakse ilmumis-

aastale (näiteks 2009a, 2009b, 2009c). Järjestamisel lähtutakse pealkirja esimese sõnast. 

 

Allikad, millel autorit ei ole (näiteks kogumikud, mis sisaldavad paljude autorite artik-

leid), järjestatakse kasutatud kirjanduse loetlus pealkirja esimese sõna järgi. Kogumike, 

teatmike, sõnastike jmt puhul võib kasutada ka teose pealkirja suurtähtlühendit. 

 

Raamatuid viidatakse järgmiselt: Autori(te) perekonnanimi ja eesnimi või eesnime init-

siaal(id) Ilmumisaasta. Pealkiri. Ilmumiskoht: Kirjastus. 

Kalle, Eedo, August Aarma 2005. Teadustöö alused. Tallinn: Tallinna Tehnika-

ülikool. 

Kalle, E., A. Aarma 2005. Teadustöö alused. Tallinn: Tallinna Tehnikaülikool. 
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NB! Kusjuures kui autori eesnimi kirjutada välja, siis tuleb seda teha läbivalt kõigi kasu-

tatud kirjanduse loetelus nimetatud allikate puhul. Sama kehtib ka eesnime initsiaaliga 

piirdudes. 

 

Autorita raamatul alustatakse raamatu pealkirjast ja kui on tiitellehel märgitud toimetaja 

ja/või koostaja, siis lisatakse tema nimi pärast teose pealkirja. 

KASM = Kõigi aegade säravaimad mõtted kahel real või veel lühemalt 2001. Toim. 

J. Shanahan. Tallinn: Ersen. 

ÕS 1999 = Eesti keele sõnaraamat ÕS 1999. Toim. Tiiu Erelt. Koost. Tiina Leemets, 

Sirje Mäearu, Maire Raadik, Tiiu Erelt. Tallinn: Eesti Keele Sihtasutus. 

NB! Koostaja ja/või toimetaja nimi lisatakse viitekirjesse vaid juhul, kui see on märgitud 

töö tiitellehel. 

Vabakasvatus... = Vabakasvatus Rudolf Steineri pedagoogikas 1999. Tallinn: Eesti 

Õppekirjanduse Keskus. 

 

Autorita, koostajata ja tiiteltoimetajate raamatud on enamasti teatmeteosed, ka sõnaraama-

tud jms. Tekstiviitena võib nende puhul kasutada ka tavaks saanud lühendeid, mis pan-

nakse siis kasutatud kirjanduse loetelus viitekirje ette. 

Teose nimetus Köide. Ilmumisaasta. Ilmumiskoht: Kirjastus. 

EE 8 = Eesti Entsüklopeedia 8. köide. 1995. Tallinn: Eesti Entsüklopeediakirjastus. 

Loodusentsüklopeedia 2004. Tallinn: Avita. 

Longman Dictionary of English Language and Culture 1998. England: Pearson 

Education Limited. 

 

Artiklid 

a) artiklid ajakirjas. Artikli autor Ilmumisaasta. Artikli pealkiri. – Ajakirja või jätkvälja-

ande nimetus, väljaande number, artikli leheküljenumbrid. 

Kukk, K. 1997. Arvuti kui haigus. – Arvutimaailm, nr 3, lk 24–25. 

Pilvre, B. 2003. Kes räägib teleekraanil? Naised meedia kõverpeeglis. – Akadeemia, 

nr 9, lk 1981–2000. 

Covington, M. V. 2000. Goal Theory, Motivation and School Achievement: An 

Integrative Review. – Annual Reviews of Psychology, Vol 51, pp 171-200. 
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Artikkel, mis on avaldatud ajakirja kahes numbris: 

Ehala, Martin 1999. Eesti väldete probleemi üks lahendusi. – Keel ja Kirjandus, nr 6 

ja 7, lk 378–385 ja 453–465. 

 

b) artiklid ajalehes. Artikli autor Ilmumisaasta. Artikli pealkiri. – Ajalehe nimetus, 

ilmumiskuupäev (päev. kuu), ajalehenumber, vajadusel võib lisada leheküljenumbrid. 

Taagepere, Rein 2006. Eestlaskonna keetmine. – Postimees, 12. aprill, nr 85. 

McGuire, S. 2001. Blair vs The press. – Newsweek, May 21, p. 16-20. 

Autorita artikli puhul on artikli pealkiri autori positsioonil: 

New Exam for the Doctor of Future 1989. – The New York Times, 15.03., B-10. 

Kui artiklil puudub nii autor kui ka pealkiri (lühisõnum, repliik jms), paigutatakse autori 

positsioonile sulgudesse sisu avav lause: 

(J. Aaviku kõne Soome Emakeele Seltsis) 2006. – Postimees, 16.sept, nr 666. 

 

c) artiklid kogumikus. Artikli autor Ilmumisaasta. Artikli pealkiri. –Väljaande pealkiri ja 

number. Koostaja või toimetaja. Ilmumiskoht: Kirjastus, leheküljenumbrid. 

Õim, Haldur 1976. Kas inimkeel on päritav? – Keel, mida me uurime. Koost. Mart 

Mäger. Tallinn: Valgus, lk 158–161 

Sariväljaande puhul lisandub viitekirjesse ka sarja nimetus. 

Hennoste, Tiit 1997. Eesti keele sotsioperioodid. Üldpilt. – Pühendusteos Huno 

Rätsepale. Tartu Ülikooli eesti keele õppetooli toimetised 7. Tartu: Tartu Ülikooli 

Kirjastus, lk 45–66. 

 

Õigusaktid 

Akti pealkiri. Akti nimetus. Vastuvõtmise aeg. // Allikas, milles akt on ametlikult aval-

datud. Kui akt on kättesaadav ka internetis, siis lisatakse viitekirjele veebiviide ja sulgudes 

selle kasutamise kuupäev. 

GRÕ = Gümnaasiumi riiklik õppekava. Vabariigi Valitsuse määrus nr 13. 28.01.2010 

// Riigi Teataja I 2010, 6, 21; https://www.riigiteataja.ee/akt/13272925 (18.05.2011) 

Looduskaitseseadus. Seadus 21.04.2004 // Riigi Teataja I, 10.03.2011, 6; https:/ 

/www.riigiteataja.ee/akt/110032011006 (18.05.2011) 

 

Internetimaterjalidele võib viidata ainult siis, kui materjalil on välja toodud autor, koos-

taja või väljaandja, kui sama materjali ei ole võimalik usaldusväärsematest allikatest kätte 

https://www.riigiteataja.ee/akt/13272925
https://www.riigiteataja.ee/akt/110032011006
https://www.riigiteataja.ee/akt/110032011006
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saada või kui on tegemist uurimisküsimusest lähtuva materjaliga. Siinkohal tuleb kindlasti 

erand teha riigi poolt e-kujul väljaantavatele materjalidele, mida Eestis paberil välja ei 

antagi. Kui kasutatakse internetist loetud allikat, mis on ka paberväljaandena samal kujul 

välja antud, tuleb viidata mõlemale. Veebiviite järel ümarsulgudes peab olema märgitud 

materjali kasutamise kuupäev, kuna artikkel võidakse internetist kustutada ja siis on töö 

autoril viite korrektsust raske tõestada. Veebiviide ei tohi olla värviline, samuti mitte alla-

joonitud. Küll aga võib veebiviite vormistamisel kasutada 11-punktist kirja. 

Autori nimi Ilmumisaasta (kui see on teada). Pealkiri. Vajadusel ka väljaandja; URL-

aadress (materjali kasutamise kuupäev) 

Nowakowsky, J. 1996. Constructivist Model for Learning; http//www.ncrel.org/sdrs/ 

areas/issues/content/cntareas/science/sc5model.htm. (24.02.1998) 

Tiit, E.-M. 2006. Eesti rahvastiku põhinäitajad aastail 2005−2006 Euroopa taustal. 

Rahvastikuministri Büroo; www.rahvastikuminister.ee/upload/dokumendid/tiit_2006. 

doc (25.09.07) 

Eesti kuulub teadus- ja arendustegevuse kasvutempolt Euroopa Liidu juhtriikide 

hulka 2008. Statistikaameti kodulehekülg; http://www.stat.ee/18962 (04.12.2008) 

Talts, L. 2008. Barbie kui lapse kasvataja. – Maaleht, 28. juuni; www.maaleht.ee/ 

talts0098765kki (16.08.2009) 

Eesti Draamateatri kodulehekülg; http://www.draamateater.ee/ (04.12.2008) 

Ajaveebi postitused (kui on olemas konkreetne autor) 

Tarand, Gerd 2010. Sotsiaalmeedia ajalugu, kirjakandjast tänaseni [ajaveebi posti-

tus, 10. dets]; http://www.gerdtarand.eu/arhiiv/6806 (17.12.2010) 

Samuti kui autorita trükiste puhul võib siingi viitesulus kasutada pealkirja lühendit või esi-

mest sõna, sel juhul peavad need kirjanduse loetelus olema esimesel kohal, millele järgneb 

võrdusmärk. 

HL = Histoire du Louvre 2003. Louvre’i kodulehekülg; http://www.louvre.fr/ 

(20.08.2003). 

 

Elektroonilisele kirjavahetusele viidatakse kui personaalsele kommunikatsioonile ainult 

tekstis ja seda ei kajastata allikate loetelus. 

 

Kirjastamata allikate viitamise puhul on oluline anda kirjanduse loetelus piisavalt infor-

matsiooni, et lugejal oleks võimalik allikad üles leida. Kirjastamata allikad on uurimis- ja 

http://www.rahvastikuminister.ee/upload/dokumendid/tiit_2006
http://www.stat.ee/18962
http://www.maaleht.ee/%20talts0098765kki
http://www.maaleht.ee/%20talts0098765kki
http://www.draamateater.ee/
http://www.gerdtarand.eu/arhiiv/6806
http://www.louvre.fr/
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lõputööd, õppematerjalid, memuaarid, intervjuud, märkmed jms. Kirjastamata allikaid 

viidatakse sõltuvalt nende kohta olemasolevast informatsioonist. 

Paju, Johannes 2000. Johannes Paju (sünd 1914) mälestused. Kirja pandud 10. 

oktoobril uurimistöö autori poolt. 

Küsitluse ,,Kool ajas“ materjalid.Tallinna Reaalkooli raamatukogu. 

AS Tornimäe Apteegid raamatupidamisbilansid 1993.−2002. a. 

Klassipäevik 2001. Saaremaa Ühisgümnaasium. Kuressaare. 

Magistri-, bakalaureuse-, diplomi- ja kursusetöö kirje puhul lisatakse käsikirja liik ja asu-

koht (teaduskond, õppetool, raamatukogu vms). Trükisena avaldatud tööde puhul üksnes 

töö liik. 

Kumari, Vaike 2005. Hindamisvahendite komplekti koostamine ja katsetamine alg-

klassiõpilaste verbaalse mõtlemise ja mälu hindamiseks. Magistritöö. Käsikiri Tartu 

Ülikooli sotsiaal- ja haridusteaduskonnas. 

Mikita, V. 2000. Kreatiivsuskäsitluste võrdlus semiootikas ja psühholoogias. 

Magistritöö. Tartu: Tartu Ülikooli Kirjastus. 

Krull, A. 1926. Päevaraamat. Käsikiri Tartu Ülikooli germaani-romaani filoloogia 

osakonnas. 

 

Intervjuude viitekirjete vormistamise võimalusi on mitu, millest seast võib valida endale 

meelepäraseima. Küll aga tuleb järgida vormistamise ühtsuse põhimõtet. 

Intervjueeritava nimi. Intervjuu pealkiri. Intervjueerija nimi, intervjueerimise aeg ja koht. 

[intervjuu salvestuse vorm (käsikiri, helisalvestus, videolindistus)]. 

Eller, Maili. Käina raamatukogu minevikust. Eveliis Eller, 21.08.2000, Käina. 

[Autori üleskirjutis] 

Intervjueeritava nimi. Intervjuu pealkiri. Intervjueerija üleskirjutus. Intervjueerimise koht: 

aeg. 

Tiits, Maret. Mälestused Tallinna 2. Keskkooli tantsuringist. Toivo Tuuliku üles-

kirjutus. Elva: 18.05. 1985. 

Intervjueeritava ees-ja perekonnanimi (soovitavalt ka töökoht, amet vms). Intervjueerija 

nimi. [Intervjuu liik]. Toimumise koht: aeg. 

Kasesalu, Toivo (Medical OÜ müügidirektor). Toivo Tuulik. [Helisalvestis]. Tallinn: 

18. 04. 2003. 

Kasesalu, Toivo (Medical OÜ müügidirektor). Toivo Tuulik. [E-kiri]. Tallinn: 18. 

04. 2003. 
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Intervjueeritava nimi. Intervjueerija nimi. [Intervjuu tüüp (üleskirjutus või helisalvestis)]. 

Intervjueerimise koht, kuupäev. Kui intervjueerinud on autor ise, siis tuleb allikmaterjalide 

loetelus näidata intervjueeritava nimi, intervjuu tüüp (üleskirjutus või helisalvestis), inter-

vjueerimise aeg ja koht. 

Madis Milk. Autori intervjuu. [Üleskirjutis]. Tartu, 16. aprill 1997. 

 

Soovitav oleks tagada algallika kättesaadavus lugejale. Seega intervjuu võiks olla esitatud 

lisas kirjalikul kujul, tööle lisatud heli- või videosalvestisena plaadil, viitena interneti-

materjalile vm. 

 

Audio-visuaalsed allikad 

a) filmid, videod 

Jamnes, P. 2000. Käitumine töölevõtu intervjuul. [Film]. AMI. 

Marshall, R. (Director), J. Bruckheimer (Producer) 2011. Pirates of the Caribbean: 

On Stranger Tides. [Film]. USA: Walt Disney Studios Motion Pictures. 

b) kassetid, CD-d ja DVD-d 

Rebane, T. (Režissöör). Jõulujutud. VAT Muinasjutt. [Kassett]. Tallinn: Eesti 

Raadio. 

Agu, M. (Produtsent) 1997. Kodused tantsud. [CD]. Tallinn: Eesti Raadio. 

c) arvutiprogrammid 

Estonia 1998. Microsoft Encarta 98 Encyclopedia. [CD-ROM]. Microsoft Corpo-

ration. 

 

Arhiivimaterjalid 

Säiliku nimetus. Arhiivi täielik nimetus, fondi (f) number, nimistu (n) või toimiku (t) 

number, säiliku (s) number, vajadusel ka mapi (m) number. Tekstisiseses viitesulus võib 

kasutada lühendeid ja numeratsiooni, need peavad eelnema kirjele võrdusmärgiga. 

EAA = Jaani kiriku meetrikaraamat. Eesti Ajalooarhiiv, f 1294, n 1, s 113 A/I–III. 

Kui arhiivi või muuseumi kogud asuvad mitmes erinevas kohas, lisatakse linna nimi. 

ERA = Eesti Rahva Muuseum, s-ü 210:280, Rakvere. 

 

Kaudviitamisel esitatakse mõlema teose andmed, kusjuures esimesel kohal on viidatav 

autor ja teos, teisel kohal teos, mille järgi viidatakse. Eraldusmärgiks on semikoolon. 
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Nilsson, M. 1951. Die Götter des Symposions. Lund: Universitet; viidatud Murray, 

O. 2001. Inimene ja sotsiaalsuse vormid. Tallinn: Avita järgi. 

Girouard, F. 1978. The Return to Camelot. Yale: University Press; viidatud Toiva-

nen, E. 2002. Õhtusel jalutuskäigul Euroopas. Tallinn: Varrak järgi. 

 

Muudel juhtudel tuleb abi saamiseks pöörduda juhendaja poole. 



47 

 

7. JUHENDAJA ROLL UURIMISTÖÖ KOOSTAMISEL 

 

Juhendaja on T32K õpetaja, kes aitab nõu ja jõuga õpilasel uurimistööd koostada. Nagu 

uurimistöö tegemisel üldse, peaks ka juhendaja valikul olema initsiatiiv õpilasepoolne. 

Juhendaja juhib uurimistöö kirjutamise protsessi ja annab õpilasele konstruktiivset tagasi-

sidet. Ta on õpilase innustaja ja tugisammas, kuid samas ka töö õiglane kritiseerija. Juhen-

daja ei ole uurimistöö autor ega toimetaja, vaid tema ülesanne on suunata õpilast sisuliselt 

täiusliku töö poole ja juhtida tähelepanu töö sisulistele puudustele. Uurimistöös esitatud 

andmete ja viidete õigsuse ning töö vormistuse eest vastutab siiski õpilane ise! 

 

Juhendaja ülesanded: 

 pakub välja uurimisteema ja oskab antud teemat juhendada, st teab juba teemat 

pakkudes vähemalt kolme allikat, kust asjakohast teoreetilist taustainfot leida ja 

mida ka õpilasele soovitada; 

 aitab õpilasel formuleerida töö eesmärgi, uurimisülesande ja struktuuri; 

 aitab õpilasel koostada uurimistöö kava ja kalenderplaani, st ajakava; 

 annab suuna teemakohase kirjanduse ja algallikate otsimiseks; 

 aitab õpilasel valida uurimuseks sobiva metoodika; 

 konsulteerib õpilast uurimistöö käigus; 

 korraldab vajaduse korral suhtlemist õpilase ja vastava valdkonna konsultandiga; 

 kontrollib töö valmimist osade kaupa; 

 suunab töö sisulist ja kirjalikku vormistamist ning järgib uurimistöö vormistamise 

nõuetest kinnipidamist; 

 otsustab uurimistöö kaitsmisele lubamise; 

 aitab õpilasel koostada kaitsekõnet ja seda ilmestavat näidismaterjali (PowerPoint 

esitlus vms); 

 hindab õpilase uurimistöö valmimise protsessi. Juhendaja hinnangu vormi leiab 

käesoleva juhendi lisast 7. 

 

Õpilane valib juhendaja vastavalt teemale, mida juhendaja on nõus juhendama. Uurimistöö 

juhendajaks võib olla ka oma ala asjatundja väljaspoolt kooli, kuid sel juhul peab uurimis-

töö kaasjuhendajaks olema ka üks T32K õpetaja. Juhendaja kinnitab oma nõusoleku töö 

juhendamiseks allkirjaga õpilase uurimistöö kaval (vt lisa 1). 
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Ühe kuu jooksul pärast teema kinnitamist on nii õpilasel kui juhendajal õigus mõjuval 

põhjusel koostööst loobuda. Loobumise korral teeb õpilane või juhendaja vastavasisulise 

kirjaliku avalduse kooli juhtkonnale, mis vaadatakse kolme tööpäeva jooksul läbi uurimis-

tööde ainetevahelise komisjoni esimehe ja juhtkonna esindaja poolt. Kui avaldus rahulda-

takse, tuleb õpilasel leida endale kiiremas korras uus juhendaja, vajadusel ka uus uurimis-

teema ning kinnitada need uurimistööde ainetevahelise komisjoni esimehe juures, esitades 

kokkulepitud tähtajaks uurimistöö esialgse kava (vt lisa 1). 

 

Valminud uurimistöö kaitsmisele lubamise otsustab töö juhendaja. Kui juhendaja on 

uurimistöö kaitsmisele lubanud, siis sellega ta kinnitab, et uurimistöö vastab T32K-s kehti-

vatele uurimistöö koostamise ja vormistamise nõuetele ning soovitab lugeda töö edukalt 

sooritatuks. 

 

Pärast uurimistöö valmimist annab juhendaja uurimistööle omapoolse hinnangu, mis lähtub 

põhimõttest, et see on hinnang ka tema tööle. Juhendaja hinnangus arvustatakse nii 

uurimistöö sisu, vormistust kui uurimistöö valmimise protsessi. Viimase aspekti hindami-

sel võetakse vaatluse alla õpilase ja juhendaja koostöö, õpilase planeerimisoskus, tähtaega-

dest ja kokkulepetest kinnipidamine ning õpilase isiklik tööpanus. Juhendaja hinnangu 

vorm on esitatud siinse juhendi lisas 7. 

 

Juhendaja hinnang esitatakse trükitult kahes eksemplaris (kaitsmiskomisjonile ja uurimis-

töö autoriks olnud õpilasele). Juhendaja hinnang peab jõudma kaitsmiskomisjonini 

vähemalt kolm tööpäeva enne kaitsmist. Juhendaja hinnang loetakse ette uurimistöö 

kaitsmisel ja soovitav on juhendajal kaitsmisel ka ise sõna võtta. 

 

 

Samuti on soovitatav juhendajal juhendatava õpilasega pärast kaitsmist kohtuda, et arutada 

läbi, kuidas kaitsmine läks, ning tunnustada õpilast hea sõnaga. 
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8. UURIMISTÖÖ RETSENSEERIMINE 

 

Retsensent on uurimistöö arvustaja, kelleks on üldjuhul antud töö ainevaldkonda hästi 

tundev T32K õpetaja või vastava aine spetsialist väljaspool kooli. Üheks õpilasuurimistöö 

retsensendiks on ka uurimistöö autori kaasõpilane, kes saab enda kirjutatud retsensiooni 

eest hinde eesti keele ainekursuse raames. Retsensent koostab uurimistööle retsensiooni, 

kus avaldab arvamust uurimistöö sisulise külje, autori saavutuste ja peamiste töös esinevate 

puuduste kohta. 

 

ÕPILASRETSENSIOONI alguses tuleb välja tuua uurimistöö lühikirjeldus: 

Retsensioon 

              klassi õpilase                      (nimi)                       uurimistööle                                   . 

                                                                   (teema)                                                                  . 

Retsenseeritava uurimistöö maht on      lehekülge, millest põhiosa moodustab       lehekülge 

ja lisad       lehekülge. Uurimistöö koosneb         sisupeatükist ning sisaldab sissejuhatust ja 

kokkuvõtet, kasutatud kirjanduse loetelu ja     lisa. Materjali illustreerimiseks on töös 

kasutatud        joonist ja         tabelit. Kasutatud kirjanduse loetelus on          nimetust. 

 

Seejärel kommenteeritakse uurimistööd järgmistest kriteeriumitest lähtuvalt: 

 uuritava probleemi aktuaalsus ja tähtsus, probleemiseade põhjendatus; 

 sisu vastavus teemale ja pealkirjale, püstitatud eesmärkidele ja ülesannetele; 

NB!  Töö eesmärk, ülesanded ja teemavaldkond tuleb retsensioonis ka lühidalt nimetada! 

 töö ülesehituse terviklikkus ja selle osade omavaheline seotus, ülesehituse loogilisus 

ning liigenduse otstarbekus; 

 teemale vastava kirjanduse kasutamine, materjali läbitöötatus ning selle selge ja 

loogiline esitus; 

 autori omapoolne intellektuaalne panus; 

 argumentatsiooni veenvus, järelduste ja ettepanekute põhjendatus; 

 töö vormistuslik ja keeleline korrektsus, viitamissüsteemi kasutamise korrektsus; 

 kasutatud kirjanduse ja muude allikmaterjalide loetelu autoriteetsus, viidetele vasta-

vus ja nõuetekohane vormistus; 
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 töö maht (st kas töö pikkus on sisuliselt õigustatud, kas töö vastab mahule 15−25 

sisulehekülge, st alates sissejuhatuse lõpust kuni kokkuvõtte alguseni ehk siis esi-

mese sisupeatüki algusest kuni viimase sisupeatüki lõpuni); 

 töö teoreetiline ja praktiline väärtus. 

Lõpetuseks lisatakse eraldi ridadele retsensiooni koostaja nimi, klass ja retsensiooni koos-

tamise kuupäev. Retsensiooni orienteeruvaks pikkuseks on 1−2 lehekülge ja see esitatakse 

trükitult kahes eksemplaris (eesti keele õpetajale ja retsenseeritud töö autorile). 

 

Hinnangu vorm ÕPETAJAST RETSENSENDILE on esitatud lisas 8. Õpetaja koostatud 

retsensiooni lõpus esitatakse uurimistöö kaitsjale 3−4 sisulist küsimust, et selgitada 

välja, kuivõrd õpilane valdab uurimistöö teemaga seonduvat materjali. 

Näiteks: Elulookirjelduste uurimine on õpilaste hulgas populaarne (lk 16). Millisele 

faktile või millisele allikale tuginedes uurimistöö autor seda väidab? 

Küsimused peavad olema esitatud selliselt, et need võimaldavad oma seisukohti põhjen-

dada ning on seotud uurimistöös esitatud probleemi, eesmärgi, ülesannete, metoodika või 

järeldustega. Retsensendi küsimustele vastab õpilane kaitsmisel. 

 

Retsensendid peavad saama uurimistöö kätte hiljemalt kaks nädalat enne kaitsmist ja 

retsensioonid peavad jõudma nii töö koostajani kui kaitsmiskomisjonini (õpilasretsen-

sioon eesti keele õpetajale) vähemalt kolm päeva enne kaitsmist. Retsensioon esitatakse 

trükitult kahes eksemplaris (komisjonile/eesti keele õpetajale ja uurimistöö autoriks olnud 

õpilasele). Uurimistöö kaitsja saab retsensioonidega tutvuda hiljemalt kolm päev enne 

kaitsmist. Õpetaja koostatud retsensioon loetakse ette uurimistöö kaitsmisel ja soovi korral 

võib õpetajast retsensent kaitsmisel ka ise sõna võtta. 
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9. UURIMISTÖÖ KAITSMINE 

 

Uurimistöö kaitsmine toimub kaitsmiskomisjoni ning grupi kaasõpilaste ees. Komisjoni 

koosseis ja õpilasgrupid määratakse kooli juhtkonna poolt. Uurimistöö autor ei tutvusta 

end ise, vaid seda teeb kaitsmiskomisjoni esimees ning töö autor kordab üle vaid uurimis-

töö teema. Uurimistöö kaitsmine seisneb õpilase lühiettekandes ja küsimustele vasta-

mises. Kaitsekõne peab olema arusaadav ja tooma välja peamise. Selles arvestatakse ka 

retsensentide märkusi ja vastatakse nii retsensentide kui kuulajate küsimustele ettekande 

lõpus. Tähtis on nii uurimistöö koostaja esinemisoskus kui ka kompetentsus küsimustele 

vastamisel. Kaitsekõne ilmestamiseks on soovitav kasutada näitlikustavat abimaterjali 

(näiteks PowerPoint, stendiettekanne, multimeedia, audiovisuaalsed materjalid jms). Õpi-

lase ettekandeks, st kaitsekõneks on aega 10 minutit. 

 

Kaitsmisprotseduur: 

1. Uurimistöö autori pöördumine: „Lugupeetud/austatud uurimistööde kaitsmiskomisjon, 

retsensent, juhendaja, kohalviibijad.“ 

2. Minu uurimistöö on kirjutatud teemal „…“. 

3. Ülevaade uurimistööst: „Uurimistöö on kirjutatud … lehel. Koosneb … peatükist, sisse-

juhatusest ja kokkuvõttest. Sisaldab … joonist ja … tabelit. Kirjanduse loetelus on … 

nimetust.“ 

4. Töö autor esitab kaitsekõne teksti, tuues esile töö eesmärgid, uurimise vajaduse põhjen-

duse ja senitehtu kirjelduse, uurimuse tulemused ja järeldused, uuringu olulisuse ja 

tulemuste võimaliku rakenduse. Võimalusel illustreeritakse suulist ettekannet näitliku 

abimaterjaliga (PowerPoint ettekanne vms). 

5. Kaitsekõne lõpetamine: „Tänan kuulamast.“ 

6. Kaitsmiskomisjoni esimees loeb ette õpetajast retsensendi koostatud retsensiooni või 

sõna saab õpetaja–retsensent. 

7. Uurimistöö autor vastab retsensendi küsimustele. 

8. Kui teistel kohalviibijatel, sh kaitsmiskomisjoni liikmetel on küsimusi, siis vastab töö 

autor ka neile. Küsimuste esitamist ja vastamist suunab kaitsmiskomisjoni esimees. 

9. Sõna saab juhendaja, kes esitab uurimistööle oma hinnangu. Kui juhendajat kaitsmisel 

ei viibi, siis loeb kaitsmiskomisjoni esimees ette juhendaja kirjaliku hinnangu. 

10. Kaitsmiskomisjoni esimees annab lõppsõna õiguse uurimistöö autorile. 
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11. Uurimistöö autor tänab kaitsmiskomisjoni, retsensente ja juhendajat. Vajadusel veel 

kolmandaid isikuid, kes on uurimistöö valmimisele otseselt kaasa aidanud. Samuti 

võib tänada kuulajaid tähelepanu eest. 

12. Kaitsmiskomisjoni esimees tänab autorit ja kaitsmiskomisjon koguneb n-ö kinniste 

uste taha, et hinnata uurimistööd ja selle kaitsekõne. 

 

Kaitsmisel kasutatakse ainult korrektset keelt, uurimistöö kaitsja väljendus on selge ja aru-

saadav ning kõnetempo rahulik. Välditakse väga pikki, ülekoormatud liitlauseid. Olulised 

märksõnad on ka veenvus ja pädevus antud valdkonnas. Retsensendile vastates ollakse 

viisakas ja kui retsensendi kriitika on õigustatud, siis tuleb see omaks võtta. 

 

Õpilase kaitsekõnet, esinemisoskust ning asjatundlikkust küsimustele vastamisel hindab 

uurimistööde kaitsmiskomisjon lisas 9 esitatud hindamismudeli alusel. 

 

Õpilasel on õigus vaidlustada kaitsmisprotseduuriga seotud küsimused kolme töö-

päeva jooksul pärast kaitsmist, esitades direktorile kirjaliku apellatsioonikaebuse. Kui 

direktor kaebuse rahuldab, saab õpilane õiguse oma tööd uuesti kaitsta veel sama õppe-

aasta sees. 

 

Kui kaitsmisel selgub, et esitatud töö ei vasta T32K uurimistööde koostamise ja vormis-

tamise juhendile (näiteks töö ei vasta teemale, on lõpetamata või on maha kirjutatud, st 

plagiaat) võib kaitsmiskomisjon otsustada tööd mitte hinnata. Uurimistöö koostajale tea-

tatakse uurimistöö täiendamiseks ja esitatud märkuste kõrvaldamiseks järelkaitsmise kuu-

päev. Uurimistöö mittehindamise ja järelkaitsmisele lubamise otsuse poolt peab hääletama 

⅔ kaitsmiskomisjoni liikmetest. 

 

Järelkaitsmise protseduurid on analoogsed õigeaegse kaitsmisega, küll aga koostavad nii 

töö juhendaja kui õpetajast retsensent (kelleks ei pea olema sama õpetaja, kes esimesel 

korral tööd retsenseeris) parandatud ja viimistletud uurimistööle nii uue hinnangu kui ret-

sensiooni, mis peavad kaitsmiskomisjonini ja õpilaseni jõudma vähemalt kaks päeva 

enne järelkaitsmist. Parandatud ja viimistletud uurimistöö peab olema esitatud kahes 

köidetud eksemplaris ja ka pdf-failina nii kaitsmiskomisjonile kui õpetajast retsensendile 

hiljemalt 10 päeva enne järelkaitsmist. 
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10. UURIMISTÖÖ HINDAMINE 

 

Uurimistöö hindamisel arvestatakse järgmisi aspekte: 

1) uurimistöö sisu, sh uurimistöö vastavust teemale, seatud eesmärkide saavutamist, 

meetodite valikut ja rakendatust; 

2) uurimistöö vormi, sh referatiivse ja uurimusliku osa tasakaalu, töö liigendatust, 

vormistamisnõuete täitmist, tööd allikatega ning keelelist korrektsust ja enese-

väljendusoskust; 

3) uurimistöö protsessi, sh planeerimist, tähtaegadest kinnipidamist, suhtumist töö-

protsessi ja kontakti juhendajaga; 

4) uurimistöö avalikku esinemist ehk kaitsmist. 

Kaitsmiskomisjon arvestab hindamisel nii juhendaja kui õpetajast retsensendi hinnangut 

uurimistööle, samuti õpilase ettekannet ja esinemist uurimistöö kaitsmisel. 

 

Tallinna 32. Keskkoolis hinnatakse uurimistööd 87 punkti süsteemis: 

Juhendaja hinnang   40 punkti 

Õpetajast retsensendi hinnang 30 punkti 

Kaitsmine    17 punkti 

KOKKU: 87 punkti 

 

Uurimistöö eest saadud punktidele lisanduvad ainekursuse „Uurimistöö alused“ raames 

sooritatud jooksvate ülesannete, kontrolltööde ja kahel kollokviumil osalemise eest saadud 

punktid – maksimaalselt 13 punkti. 

 

Viie palli süsteemi teisendades on nn uurimistöö kogupunktid ehk ainekursuse „Uurimis-

töö alused“ eest saadud punktid vastavad järgmistele hinnetele: 

90 – 100 punkti – hinne „väga hea“ ehk „5“ 

75 – 89 punkti – hinne „hea“ ehk „4“ 

50 – 74 punkti – hinne „rahuldav“ ehk „3“ 

 

Hindamisprotsessi lihtsustamiseks on nii juhendajal kui õpetajast retsensendil kasutada 

vastavad hindamismudelid, mis on esitatud siinse juhendi lisades 7 ja 8. Samuti leiab 
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lisast 9 kaitsmiskomisjonile mõeldud juhised õpilase kaitsekõne, esinemisoskuse ja küsi-

mustele vastamise kompetentsuse hindamiseks. 

 

Kui kaitsmisel selgub, et esitatud töö ei vasta T32K uurimistööde koostamise ja vormis-

tamise juhendile (näiteks töö ei vasta teemale, on lõpetamata või on maha kirjutatud, st 

plagiaat) võib kaitsmiskomisjon otsustada tööd mitte hinnata. Uurimistöö koostajale tea-

tatakse uurimistöö täiendamiseks ja esitatud märkuste kõrvaldamiseks järelkaitsmise kuu-

päev. Uurimistöö mittehindamise ja järelkaitsmisele lubamise otsuse poolt peab hääletama 

⅔ kaitsmiskomisjoni liikmetest. 

 

Kui õpilasel ei ole väga mõjuvatel põhjustel (kooli esindamisega seoses, tervislikud põhju-

sed vms) võimalik oma uurimistööd ettenähtud kaitsmispäeval kaitsta või lükkab kaitsmis-

komisjon õpilase uurimistöö tagasi ja kohustab õpilast oma tööd täiendama–korrigeerima, 

siis toimub sama õppeaasta lõpul ka uurimistööde järelkaitsmine. Kui õpilane ei ole 

kaitsnud oma uurimistööd ka järelkaitsmisel, jääb õpilasel õigus taotleda õppenõukogult 

luba kaitsta oma uurimistööd järgmise lennuga järgmise õppeaasta kevadel. 
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LISAD 

Lisa 1. Uurimistöö kava vorm 

Uurimistöö kava 

Õpilase nimi  ____________________________________________ Klass  ___________  

Uurimistöö esialgne pealkiri  ________________________________________________  

 ________________________________________________________________________  

Juhendaja /nimi, allkiri/ ____________________________________________________  

 

 

Õpilane _____________________ /allkiri/ 

Kuupäev ____________________  

Uurimistöö eesmärk ja olulisus: 

 

 

 

 

 

 

Uurimistöö ülesehitus ja ajakava: 

 

 

 

 

 

 

 

 

Uurimistöö esialgne teoreetiline kirjandus ja muud allikad: 
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Lisa 2. Uurimistöö vahearuande vorm 

Vahearuanne uurimistöö kulgemisest 

Õpilase nimi  ____________________________________________  Klass  __________  

Uurimistöö pealkiri  ________________________________________________________  

 ________________________________________________________________________  

 

Õpilane on tutvunud kirjandusega ning omab teemast ülevaadet. Töös kasutatav materjal 

on suures osas kogutud ja analüüsitud. Õpilane tegeleb tulemuste tõlgendamise ja uurimis-

töö kirjutamisega. Juhendaja on töö käiguga kursis ja hindab töö võimalust saada kaitstud. 

 

Õpilane __________________________ /allikiri/ 

Juhendaja_______________________________ /nimi, allkiri/ 

Kuupäev__________________________ 
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Lisa 7. Hinnangu vorm juhendajale 

JUHENDAJA HINNANGULEHT UURIMISTÖÖLE 

 

Uurimistöö teema:   

 

Uurimistöö koostaja:   

 

Klass:  

Juhendaja:   

 

Sisu: max 20p; Vorm: max 10p; Protsess: max 10p; KOKKU maksimaalselt 40 punkti 

SISU Hinne            5 

(punkte 4)  

Hinne            4 

(punkte 3)  

Hinne            3 

(punkte 2)  

Hinne            2 

(punkte 0)  

Punkte    

max 4 

 

Pealkiri Pealkiri 

kajastab täpselt 

uurimistöö sisu 

Pealkiri vastab 

osaliselt töö 

sisule (liiga lai, 

liiga kitsas 

vms) 

Pealkirja 

mitmekordsel 

lugemisel saab 

aru selle 

seotusest töö 

sisuga 

Pealkiri ei 

vasta töö sisule 

 

Kommentaar, 

küsimused 

 

Tehke sobiv valik ja märkige see! Punktide lahtrisse märkige saadud punktide 

arv. Vajadusel lisage kommentaar või küsimused uurimistöö koostajale. 

Enne kommentaari, küsimuste lisamist kustutage käesolev tekst. 

 

SISU Hinne            5 

(punkte 4)  

Hinne            4 

(punkte 3)  

Hinne            3 

(punkte 2)  

Hinne            2 

(punkte 0)  

Punkte    

max 4 

 

Eesmärgid, 

ülesanded, 

hüpotees(id) 

Sissejuhatuses 

püstitatud 

eesmärkidele, 

ülesannetele ja 

hüpoteesi(de)le 

on kokkuvõttes 

selged ja 

konkreetsed 

vastused 

Sissejuhatuses 

püstitatud 

eesmärgid, 

ülesanded ja 

hüpotees(id) 

sobivad 

osaliselt 

kokkuvõttega 

Sissejuhatus ja 

kokkuvõte pole 

kooskõlas; töö 

ei täida oma 

eemärke 

Sissejuhatus 

ja/või 

kokkuvõte 

puuduvad; töö 

ei täida oma 

eesmärke 

 

Kommentaar, 

küsimused 

 

 

 

 

 

SISU Hinne            5 

(punkte 4)  

Hinne            4 

(punkte 3)  

Hinne            3 

(punkte 2)  

Hinne            2 

(punkte 0)  

Punkte    

max 4 

 

Meetod Empiiriline 

materjal on 

kogutud 

sobivaima 

meetodiga ning 

Empiiriline 

materjal on 

kogutud 

ebasobiva 

meetodiga või 

Valitud on vale 

meetod ja 

kogutud 

materjali hulk 

on ebapiisav 

Ei saa aru, 

millist 

meetodit on 

materjali 

kogumisel 

 



65 

 

materjali hulk 

on piisav 

usaldusväär-

sete järelduste 

tegemiseks 

pole materjali 

hulk piisav 

usaldusväär-

seteks 

järeldusteks 

töö eesmärgi 

saavutamiseks 

kasutatud 

Kommentaar, 

küsimused 

 

 

 

 

 

SISU Hinne            5 

(punkte 4)  

Hinne            4 

(punkte 3)  

Hinne            3 

(punkte 2)  

Hinne            2 

(punkte 0)  

Punkte    

max 4 

 

Uurimus Uurimuslik osa 

(küsitlus, 

katsed, 

eksperiment 

vm) on hästi 

koostatud/ 

läbiviidud ning 

tulemusi on 

võrreldud 

piisavalt töö 

esimeses osas 

käsitletud 

materjalidega 

Uurimusliku 

osa 

koostamisel/ 

läbiviimisel 

esineb 

üksikuid vigu 

ja/või on 

tulemusi 

võrreldud töö 

esimese osaga 

vaid osaliselt 

Uurimuslik osa 

on koostatud/ 

läbiviidud 

küsitavalt 

ja/või on 

tulemusi 

võrreldud töö 

esimese osaga 

puudulikult 

Uurimusliku 

osa ja töö 

esimese osa 

vahel puudub 

otsene seos 

 

Kommentaar, 

küsimused 

 

 

 

 

 

SISU Hinne            5 

(punkte 4)  

Hinne            4 

(punkte 3)  

Hinne            3 

(punkte 2)  

Hinne            2 

(punkte 0)  

Punkte    

max 4 

 

Analüüs ja 

arutelu 

(järeldused) 

Uurimis-

tulemuste 

analüüs on 

põhjalik, 

arutelu on 

selge, täpne ja 

süsteemne 

Uurimis-

tulemuste 

analüüs või 

omasõnaline 

arutelu on liiga 

pealiskaudne 

Uurimis-

tulemuste 

analüüs ja 

arutelu on 

puudulikud 

Tegemist on 

referatiivse 

tööga, kus 

puuduvad 

omasõnalised 

järeldused 

 

Kommentaar, 

küsimused 

 

 

 

 

 

VORM Hinne            5 

(punkte 1) 

Hinne            4 

(punkte 0,75) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Struktuur Töö liigendus 

ja pealkirjad 

on selged ja 

põhjendatud 

Töö liigenduse 

ja/või 

pealkirjade 

osas esineb 

üksikuid 

puudujääke 

Töö on liiga 

palju või liiga 

vähe 

liigendatud 

ja/või 

pealkirjad ei 

sobi sisuga või 

on liiga pikad 

Töö on 

liigendamata 

või liigendatud 

ebaotstarbekalt 
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Kommentaar, 

küsimused: 

 

 

 

 

 

 

VORM Hinne            5 

(punkte 1) 

Hinne            4 

(punkte 0,75) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Struktuur Uurimistöö 

referatiivne ja 

uurimuslik osa 

on tasakaalus 

Uurimistöö 

referatiivne osa 

on töös liiga 

väike 

Referatiivne 

osa on töös 

liiga suur, 

mistõttu 

uurimuslik osa 

on väike 

Uurimistöö on 

referatiivne 

ning 

uurimuslik osa 

puudub 

 

Kommentaar, 

küsimused: 

 

 

 

 

 

 

 

VORM Hinne            5 

(punkte 1) 

Hinne            4 

(punkte 0,75) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Lisad Lisade 

olemasolu või 

puudumine 

vastab töö 

iseloomule 

Lisade 

olemasolu või 

puudumine 

vastab 

põhiliselt töö 

iseloomule 

Lisade 

olemasolu või 

puudumine 

vastab töö 

iseloomule 

vaid osaliselt 

Lisade 

olemasolu või 

puudumine ei 

vasta töö 

iseloomule 

 

Kommentaar, 

küsimused: 

 

 

 

 

 

 

VORM Hinne            5 

(punkte 1) 

Hinne            4 

(punkte 0,75) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Uurimistöö 

üldine 

vormistus 

Uurimistöö 

vormistus on 

nõuetele vastav 

– tiitelleht, 

sisukord, 

trükiteksti 

suurus, rea-

vahed, peal-

kirjad, lk-de 

nummerdus jne 

on korrektsed  

Uurimistöö 

vormistuses 

esineb paar 

läbivat viga 

Uurimistöös 

esineb palju 

vormistusvigu 

Uurimistöös ei 

ole 

vormistusele 

pööratud 

mingisugust 

tähelepanu 

 

Kommentaar, 

küsimused: 
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VORM Hinne            5 

(punkte 1) 

Hinne            4 

(punkte 0,75) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Illustrat-

sioonide 

(tabelite, 

jooniste, 

graafikute jne) 

vormistus 

Illustratsioonid 

on vormistatud 

korrektselt – 

olemas on 

pealkirjad, jrk-

nr-d ning 

vajadusel 

viited 

algallikatele 

Illustratsioo-

nide 

vormistuses 

esineb paar 

puudust 

Illustratsioo-

nide 

vormistuses 

esineb paar 

läbivat puudust 

Illustratsioo-

nidel puuduvad 

pealkirjad ja 

viited 

algallikatele 

 

Kommentaar, 

küsimused: 

 

 

 

 

 

VORM Hinne            5 

(punkte 1) 

Hinne            4 

(punkte 0,75) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Illustratiivsus Illustratsioone 

(tabeleid, 

jooniseid jms) 

on piisavalt 

Illustratsioone 

võiks olla 

rohkem 

Illustratsioone 

võiks olla 

vähem 

Illustratsioone 

pole kasutatud, 

kuigi teema 

seda 

võimaldaks 

 

Kommentaar, 

küsimused: 

 

 

 

 

VORM Hinne            5 

(punkte 1) 

Hinne            4 

(punkte 0,75) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Refereerimine, 

tsiteerimine 

Uurimistöös on 

selgelt 

eristatud töö 

autori omad 

mõtted 

refereeritud– 

tsiteeritud 

autorite 

mõtetest 

Refereerimisel 

ja tsiteerimisel 

esineb paar 

viga, kuid 

uurimistöö 

autori omad 

mõtted on 

enamasti 

eristatavad 

Refereerimisel 

ja tsiteerimisel 

esineb 

mõningaid 

vigu, 

uurimistöö 

autori omad 

mõtted ei ole 

alati 

eristatavad 

Refreerimisel 

ja tsiteerimisel 

esineb olulisi 

läbivaid vigu, 

mistõttu 

uurimistöö 

autori omad 

mõtted ei ole 

selgelt 

eristatud 

 

Kommentaar, 

küsimused: 

 

 

 

 

 

VORM Hinne            5 

(punkte 1) 

Hinne            4 

(punkte 0,75) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Kastutatud 

materjalide 

vormistus 

Kasutatud 

materjalide 

nimekirja 

vormistus on 

korrektne, 

kirjed reastatud 

alfabeetiliselt 

Kasutatud 

materjalide 

vormistuses 

esineb 

mõningaid 

vigu 

Kasutatud 

materjalide 

vormistamisel 

on vigu 

olulisel määral 

Kasutatud 

materjalide 

nimekiri 

puudub 
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Kommentaar, 

küsimused: 

 

 

 

 

 

VORM Hinne            5 

(punkte 1) 

Hinne            4 

(punkte 0,75) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Viitamine Tekstis on 

viidatud ühtse 

süsteemi järgi 

kõikidele 

kasutatud 

allikatele, 

joonistele, 

tabelitele, 

lisadele jne 

Tekstisiseses 

viitamises 

esineb 

üksikuid vigu 

Tekstisiseses 

viitamises on 

läbivaid vigu 

või on 

tekstisisene 

viitamine 

süsteemitu 

Tekstisisene 

viitamine 

puudub 

 

Kommentaar, 

küsimused: 

 

 

 

 

 

 

VORM Hinne            5 

(punkte 1) 

Hinne            4 

(punkte 0,75) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Enese-

väljendus 

Sõnavara on 

mitmekesine, 

väljendid hästi 

mõistetavad, 

lausestus lihtne 

ja loogiline, 

õigekirjavead 

puuduvad, 

puudub slängi 

ja võõrkeelte 

mõju 

Enese-

väljenduses 

esineb mõni 

läbiv viga 

Enese-

väljenduses 

esineb kuni 15 

läbivat viga 

Enese-

väljenduses 

esineb 

hulgaliselt 

lausestus- ja 

õigekirjavigu 

 

Kommentaar, 

küsimused: 

 

 

 

 

 

 

PROTSESS Hinne            5 

(punkte 2,5) 

Hinne            4 

(punkte 1,5) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Kontakt 

juhendajaga 

Õpilase 

kontakt 

juhendajaga oli 

kogu töö vältel 

regulaarne ja 

aktiivne 

Õpilase 

kontakt 

juhendajaga oli 

kogu töö vältel 

ebaregulaarne 

ja liiga vähene 

Õpilane kohtus 

juhendajaga 

vaid paar 

korda 

Õpilane 

juhendajaga ei 

kohtunud ja 

esitas 

juhendajale 

valmis töö 

 

Kommentaar, 

küsimused: 
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PROTSESS Hinne            5 

(punkte 2,5) 

Hinne            4 

(punkte 1,5) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Planeerimine Õpilane 

planeeris ja 

teostas oma 

tööd oskus-

likult; oli alati 

juhendajaga 

kohtudes 

vajaliku eeltöö 

iseseisvalt läbi 

mõelnud 

Õpilane 

planeeris ja 

teostas oma 

tööd osaliselt 

iseseivalt; 

juhendajaga 

kohtudes oli 

eeltöö osaliselt 

tegemata 

Juhendajaga 

kohtudes oli 

õpilasel vajalik 

eeltöö 

tegemata 

Õpilane ei 

kohtunud 

juhendajaga 

 

Kommentaar, 

küsimused: 

 

 

 

 

 

PROTSESS Hinne            5 

(punkte 2,5) 

Hinne            4 

(punkte 1,5) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Tähtajad, 

kokkulepped 

Kokkulepitud 

tähtaegadest 

pidas õpilane 

kinni kogu 

tööprotsessi 

vältel 

Mõnel korral 

ei pidanud 

õpilane kinni 

kokkulepitud 

tähtaegadest 

Õpilane kohtus 

juhendajaga 

kokkulepitud 

tähtaegadel 

vaid paaril 

korral 

Õpilane ei 

pidanud kinni 

kokkulepitud 

tähtaegadest 

 

Kommentaar, 

küsimused: 

 

 

 

 

 

PROTSESS Hinne            5 

(punkte 2,5) 

Hinne            4 

(punkte 1,5) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Õpilase isiklik 

tööpanus 

Õpilane 

koostas 

uurimistöö 

iseseisvalt, 

arvestades 

juhendaja 

nõuanded ja 

soovitusi 

Õpilane 

koostas töö 

suuresti 

iseseisvalt, 

arvestades 

enamasti ka 

juhendaja 

nõuandeid ja 

soovitusi 

Õpilane 

koostas töö 

suuresti 

iseseisvalt, 

arvestamata 

seejuures 

juhendaja 

nõuandeid ja 

soovitusi 

Õpilase isiklik 

tööpanus 

uurimistöö 

valmimisse oli 

minimaalne 

 

Kommentaar, 

küsimused: 

 

 

 

 

 

Juhendaja koondhinnang (max 40p) 
 

 

 

Juhendaja allkiri:________________________ 

Hinnangu koostamise kuupäev:_____________ 
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Lisa 8. Retsensiooni vorm õpetajale 

RETSENSENDI HINNANGULEHT UURIMISTÖÖLE 

 

Uurimistöö teema:   

 

Uurimistöö koostaja:   

 

Klass:  

Retsensent:   

 

Sisu: max 20p; Vorm: max 10p; KOKKU maksimaalselt 30 punkti 

SISU Hinne            5 

(punkte 4)  

Hinne            4 

(punkte 3)  

Hinne            3 

(punkte 2)  

Hinne            2 

(punkte 0)  

Punkte    

max 4 

 

Pealkiri Pealkiri 

kajastab täpselt 

uurimistöö sisu 

Pealkiri vastab 

osaliselt töö 

sisule (liiga lai, 

liiga kitsas 

vms) 

Pealkirja 

mitmekordsel 

lugemisel saab 

aru selle 

seotusest töö 

sisuga 

Pealkiri ei 

vasta töö sisule 

 

Kommentaar, 

küsimused 

 

Tehke sobiv valik ja märkige see! Punktide lahtrisse märkige saadud punktide 

arv. Vajadusel lisage kommentaar või küsimused uurimistöö koostajale. 

Enne kommentaari, küsimuste lisamist kustutage käesolev tekst. 

 

SISU Hinne            5 

(punkte 4)  

Hinne            4 

(punkte 3)  

Hinne            3 

(punkte 2)  

Hinne            2 

(punkte 0)  

Punkte    

max 4 

 

Eesmärgid, 

ülesanded, 

hüpotees(id) 

Sissejuhatuses 

püstitatud 

eesmärkidele, 

ülesannetele ja 

hüpoteesi(de)le 

on kokkuvõttes 

selged ja 

konkreetsed 

vastused 

Sissejuhatuses 

püstitatud 

eesmärgid, 

ülesanded ja 

hüpotees(id) 

sobivad 

osaliselt 

kokkuvõttega 

Sissejuhatus ja 

kokkuvõte pole 

kooskõlas; töö 

ei täida oma 

eemärke 

Sissejuhatus 

ja/või 

kokkuvõte 

puuduvad; töö 

ei täida oma 

eesmärke 

 

Kommentaar, 

küsimused 

 

 

 

 

 

SISU Hinne            5 

(punkte 4)  

Hinne            4 

(punkte 3)  

Hinne            3 

(punkte 2)  

Hinne            2 

(punkte 0)  

Punkte    

max 4 

 

Meetod Empiiriline 

materjal on 

kogutud 

sobivaima 

meetodiga ning 

Empiiriline 

materjal on 

kogutud 

ebasobiva 

meetodiga või 

Valitud on vale 

meetod ja 

kogutud 

materjali hulk 

on ebapiisav 

Ei saa aru, 

millist 

meetodit on 

materjali 

kogumisel 
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materjali hulk 

on piisav 

usaldusväär-

sete järelduste 

tegemiseks 

pole materjali 

hulk piisav 

usaldusväär-

seteks 

järeldusteks 

töö eesmärgi 

saavutamiseks 

kasutatud 

Kommentaar, 

küsimused 

 

 

 

 

 

SISU Hinne            5 

(punkte 4)  

Hinne            4 

(punkte 3)  

Hinne            3 

(punkte 2)  

Hinne            2 

(punkte 0)  

Punkte    

max 4 

 

Uurimus Uurimuslik osa 

(küsitlus, 

katsed, 

eksperiment 

vm) on hästi 

koostatud/ 

läbiviidud ning 

tulemusi on 

võrreldud 

piisavalt töö 

esimeses osas 

käsitletud 

materjalidega 

Uurimusliku 

osa 

koostamisel/ 

läbiviimisel 

esineb 

üksikuid vigu 

ja/või on 

tulemusi 

võrreldud töö 

esimese osaga 

vaid osaliselt 

Uurimuslik osa 

on koostatud/ 

läbiviidud 

küsitavalt 

ja/või on 

tulemusi 

võrreldud töö 

esimese osaga 

puudulikult 

Uurimusliku 

osa ja töö 

esimese osa 

vahel puudub 

otsene seos 

 

Kommentaar, 

küsimused 

 

 

 

 

 

SISU Hinne            5 

(punkte 4)  

Hinne            4 

(punkte 3)  

Hinne            3 

(punkte 2)  

Hinne            2 

(punkte 0)  

Punkte    

max 4 

 

Analüüs ja 

arutelu 

(järeldused) 

Uurimis-

tulemuste 

analüüs on 

põhjalik, 

arutelu on 

selge, täpne ja 

süsteemne 

Uurimis-

tulemuste 

analüüs või 

omasõnaline 

arutelu on liiga 

pealiskaudne 

Uurimis-

tulemuste 

analüüs ja 

arutelu on 

puudulikud 

Tegemist on 

referatiivse 

tööga, kus 

puuduvad 

omasõnalised 

järeldused 

 

Kommentaar, 

küsimused 

 

 

 

 

 

VORM Hinne            5 

(punkte 1) 

Hinne            4 

(punkte 0,75) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Struktuur Töö liigendus 

ja pealkirjad 

on selged ja 

põhjendatud 

Töö liigenduse 

ja/või 

pealkirjade 

osas esineb 

üksikuid 

puudujääke 

Töö on liiga 

palju või liiga 

vähe 

liigendatud 

ja/või 

pealkirjad ei 

sobi sisuga või 

on liiga pikad 

Töö on 

liigendamata 

või liigendatud 

ebaotstarbekalt 
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Kommentaar, 

küsimused: 

 

 

 

 

 

 

VORM Hinne            5 

(punkte 1) 

Hinne            4 

(punkte 0,75) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Struktuur Uurimistöö 

referatiivne ja 

uurimuslik osa 

on tasakaalus 

Uurimistöö 

referatiivne osa 

on töös liiga 

väike 

Uurimistöö 

referatiivne osa 

on töös liiga 

suur, mistõttu 

uurimuslik on 

väike 

Uurimistöö on 

referatiivne 

ning 

uurimuslik osa 

puudub 

 

Kommentaar, 

küsimused: 

 

 

 

 

 

 

VORM Hinne            5 

(punkte 1) 

Hinne            4 

(punkte 0,75) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Lisad Lisade 

olemasolu või 

puudumine 

vastab töö 

iseloomule 

Lisade 

olemasolu või 

puudumine 

vastab 

põhiliselt töö 

iseloomule 

Lisade 

olemasolu või 

puudumine 

vastab töö 

iseloomule 

vaid osaliselt 

Lisade 

olemasolu või 

puudumine ei 

vasta töö 

iseloomule 

 

Kommentaar, 

küsimused: 

 

 

 

 

 

 

 

VORM Hinne            5 

(punkte 1) 

Hinne            4 

(punkte 0,75) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Uurimistöö 

üldine 

vormistus 

Uurimistöö 

vormistus on 

nõuetele vastav 

– tiitelleht, 

sisukord, 

trükiteksti 

suurus, rea-

vahed, peal-

kirjad, lk-de 

nummerdus jne 

on korrektsed  

Uurimistöö 

vormistuses 

esineb paar 

läbivat viga 

Uurimistöös 

esineb palju 

vormistusvigu 

Uurimistöös ei 

ole 

vormistusele 

pööratud 

mingisugust 

tähelepanu 

 

Kommentaar, 

küsimused: 
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VORM Hinne            5 

(punkte 1) 

Hinne            4 

(punkte 0,75) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Illustrat-

sioonide 

(tabelite, 

jooniste, 

graafikute jne) 

vormistus 

Illustratsioonid 

on vormistatud 

korrektselt – 

olemas on 

pealkirjad, jrk-

nr-d ning 

vajadusel 

viited 

algallikatele 

Illustratsioo-

nide 

vormistuses 

esineb paar 

puudust 

Illustratsioo-

nide 

vormistuses 

esineb paar 

läbivat puudust 

Illustratsioo-

nidel puuduvad 

pealkirjad ja 

viited 

algallikatele 

 

Kommentaar, 

küsimused: 

 

 

 

 

 

VORM Hinne            5 

(punkte 1) 

Hinne            4 

(punkte 0,75) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Illustratiivsus Illustratsioone 

(tabeleid, 

jooniseid jms) 

on piisavalt 

Illustratsioone 

võiks olla 

rohkem 

Illustratsioone 

võiks olla 

vähem 

Illustratsioone 

pole kasutatud, 

kuigi teema 

seda 

võimaldaks 

 

Kommentaar, 

küsimused: 

 

 

 

 

VORM Hinne            5 

(punkte 1) 

Hinne            4 

(punkte 0,75) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Refereerimine, 

tsiteerimine 

Uurimistöös on 

selgelt 

eristatud töö 

autori omad 

mõtted 

refereeritud– 

tsiteeritud 

autorite 

mõtetest 

Refereerimisel 

ja tsiteerimisel 

esineb paar 

viga, kuid 

uurimistöö 

autori omad 

mõtted on 

enamasti 

eristatavad 

Refereerimisel 

ja tsiteerimisel 

esineb 

mõningaid 

vigu, 

uurimistöö 

autori omad 

mõtted ei ole 

alati 

eristatavad 

Refreerimisel 

ja tsiteerimisel 

esineb olulisi 

läbivaid vigu, 

mistõttu 

uurimistöö 

autori omad 

mõtted ei ole 

selgelt 

eristatud 

 

Kommentaar, 

küsimused: 

 

 

 

 

 

VORM Hinne            5 

(punkte 1) 

Hinne            4 

(punkte 0,75) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Kastutatud 

materjalide 

vormistus 

Kasutatud 

materjalide 

nimekirja 

vormistus on 

korrektne, 

kirjed reastatud 

alfabeetiliselt 

Kasutatud 

materjalide 

vormistuses 

esineb 

mõningaid 

vigu 

Kasutatud 

materjalide 

vormistamisel 

on vigu 

olulisel määral 

Kasutatud 

materjalide 

nimekiri 

puudub 
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Kommentaar, 

küsimused: 

 

 

 

 

 

VORM Hinne            5 

(punkte 1) 

Hinne            4 

(punkte 0,75) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Viitamine Tekstis on 

viidatud ühtse 

süsteemi järgi 

kõikidele 

kasutatud 

allikatele, 

joonistele, 

tabelitele, 

lisadele jne 

Tekstisiseses 

viitamises 

esineb 

üksikuid vigu 

Tekstisiseses 

viitamises on 

läbivaid vigu 

või on 

tekstisisene 

viitamine 

süsteemitu 

Tekstisisene 

viitamine 

puudub 

 

Kommentaar, 

küsimused: 

 

 

 

 

 

VORM Hinne            5 

(punkte 1) 

Hinne            4 

(punkte 0,75) 

Hinne            3 

(punkte 0,5) 

Hinne            2 

(punkte 0) 

Punkte    

max 1 

 

Enese-

väljendus 

Sõnavara on 

mitmekesine, 

väljendid hästi 

mõistetavad, 

lausestus lihtne 

ja loogiline, 

õigekirjavead 

puuduvad, 

puudub slängi 

ja võõrkeelte 

mõju 

Enese-

väljenduses 

esineb mõni 

läbiv viga 

Enese-

väljenudses 

esineb kuni 15 

läbivat viga 

Enese-

välejnduses 

esineb 

hulgaliselt 

lausestus- ja 

õigekirjavigu 

 

Kommentaar, 

küsimused: 

 

 

 

 

 

Retsensendi koondhinnang (max 30p) 
 

 

 

Sisulised küsimused uurimistöö kaitsjale : 

1. 

2. 

3. 

 

Retsensendi allkiri:_________________________ 

Retsensiooni koostamise kuupäev:_____________ 
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Lisa 9. Hindamismudel kaitsmiskomisjonile 

HINDAMISMUDEL UURIMISTÖÖ KAITSMISE HINDAMISEKS 

 

Uurimistöö teema:   

 

Uurimistöö koostaja:   

 

Klass:  

Kaitsekõne: max 5p; Esinemisoskus: max 7p; Küsimustele vastamisoskus: max 5p; 

KOKKU maksimaalselt 17 punkti 

KAITSE-

KÕNE 

Hinne           5 

(punkte 5)  

Hinne           4 

(punkte 4)  

Hinne           3 

(punkte 3)  

Hinne           2 

(punkte 2)  

Punkte    

max 5 

 

Kaitsekõne Kaitsekõne 

annab 

uurimistööst 

igati 

ammendava 

ülevaate ja 

olemas on 

näitlikustav 

abimaterjal 

(PowerPoint 

vms) 

Kaitsekõne 

annab 

uurimistööst 

peaaegu et 

piisava 

ülevaate ja 

olemas on 

näitlikustav 

abimaterjal 

Kaitsekõne 

annab 

uurimistööst 

esmase üle-

vaate, kuid töö 

olemust tuleb 

küsimuste abil 

täpsustada, 

ja/või puudub 

näitlikustav 

abimaterjal 

Kaitsekõne ei 

anna 

uurimistööst 

vajalikku 

ülevaadet, 

samuti puudub 

näitlikustav 

abimaterjal 

 

Kommentaar, 

küsimused 

 

Tehke sobiv valik ja märkige see! Punktide lahtrisse märkige saadud punktide 

arv. Vajadusel lisage kommentaar või küsimused uurimistöö koostajale. 

 

 

 

ÕPILASE 

ESINEMIS-

OSKUS 

Hinne           5 

(punkte 5)  

Hinne           4 

(punkte 4)  

Hinne           3 

(punkte 3)  

Hinne           2 

(punkte 2)  

Punkte    

max 5 

 

Esinemisoskus Õpilase 

esinemine on 

ilmekas, 

huvitav ja 

ladusas 

tempos, 

kõnelemine 

selge ja 

loogiline ning 

keelekasutus 

kaitsekõnele 

kohane, ei 

esine parasiit-

sõnu 

Õpilase 

esinemis-

oskusel on   

1–2 

puudujääki 

Õpilase 

esinemis-

oskusel on    

3–5 

puudujääki 

Õpilase 

esinemis-

oskusel on 

olulisi 

puudujääke 

 

Kommentaar, 

küsimused 
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ÕPILASE 

ESINEMIS-

OSKUS 

Hinne           5 

(punkte 2)  

Hinne           4 

(punkte 1,5) 

Hinne           3 

(punkte 1)  

Hinne           2 

(punkte 0)  

Punkte    

max 2 

 

Ajalimiit Õpilase kaitse-

kõne mahub 

etteantud 10 

minutisse 

Õpilase kaitse-

kõne pikkus 

on 10+3 

minutit 

Õpilase kaitse 

kõne pikkus 

on 10+5 

minutit 

Õpilase kaitse-

kõne pikkus 

on kuni 5 

minutit või 

rohkem kui 15 

minutit 

 

Kommentaar, 

küsimused 

 

 

 

 

 

ÕPILASE 

VASTAMIS-

OSKUS 

Hinne           5 

(punkte 5)  

Hinne           4 

(punkte 4)  

Hinne           3 

(punkte 3)  

Hinne           2 

(punkte 2)  

Punkte    

max 5 

 

Õpilase 

kompetentsus 

küsimustele 

vastamisel 

Õpilane oskab 

arukalt ja 

enesekindlalt 

vastata 

kõikidele 

esitatud 

teema-

kohastele 

küsimustele 

Õpilane oskab 

arukalt ja 

enesekindlalt 

vastata 

enamusele 

esitatud 

teema-

kohastele 

küsimustele 

Õpilane on 

küsimustele 

vastamisel 

ebakindel, 

kuid 

enamusele 

küsimustest 

vastab 

pädevalt 

Õpilane on 

küsimustele 

vastamisel 

ebakindel ning 

oskab vastata 

vähestele 

esitatud 

küsimustele 

 

Kommentaar, 

küsimused 

 

 

 

 

 

 

Kaitmise koondhinnang (max 17p) 
 

 

 


